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Evx by Gehlot IT Consultants 
 
SCAN, PUNCH AND GO TECHNOLOGY 
Support for 

High-resolution scanner: support for many file type: JPEG, BMP, TIFF, PNG, PIC 
etc. 
Free zooming 
All parameters on screen 
One key operation on most of the commands 
Auto underlay 
Support for many type of fills 

Satin, Tatami, Complex Fill, Pattern fill, Cavity fill, E fill, Jagged fill, Tree fill, 
Bead Fill. 
And many non-standard fill, Multidirectional Tatami, Unparalleled Tatami. 
Alphabets fill for many windows fonts 

Auto corner, intelligent corners, in satin fill 
Edit functions: cut, copy, past, multilevel undo 
Clone, move, rotate, scale, mirror facility 
Reduce/ increase stitches entire design 
Increase/decrease design size. 
Import, convert design to other formats 
Print design with details 
Multiple designs printing on same page 
Auto play while punching 
Film preview, selection from film, move anywhere 

Design Management 
Evx-Explorer displays design in Icons 
Display icons of design before opening 
Display backdrops in icon manner 
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382, Block III, 
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Welcome to EVX 
Evx the new generation state of the art technology embroidery software designed and 
developed for India’s need. Its user interface and features allow users to create, edit, and 
manage embroidery designs.  It is designed to support the best embroidery quality, high 
productivity and efficiency requirements of professional digitizers. Beside all popular 
stitch types like Satin (Central Serial), Tatami (Intelligent), Running, Piping, Cross-stitch, 
Zigzag, Plasma, Goli, Jall and Motif etc it also provides water fill, ripple fill and 
peacock(Moore) fill features. Numerous tools like stitch processor, remove short stitches, 
show repeat, 3D actual View etc. take the Evx in the front line of embroidery software. 

Related topics  

Object based software 
Toolbars 
Miscellaneous commands 
Digitizing/punching 
Filling parameters 
Stitch processing 



Object based software 
Evx is object based software. Each object in the design is independent of other objects 
and has a different property set. Property set is composed of color of the object, its type, 
its shape, size, position and besides other properties; its stitch type is one of very 
important property for us. Embroidery blocks are generated, crafted, molded, and edited 
to suit the requirements of the user. 

General Concepts 
This section describes the general concept of Evx. It also describes the directory structure 
and maintaining designs with reference to various companies. 

Working with design files 

This section deals with how to start the Evx embroidery punching software and use basic 
commands. It also explains how to open existing designs, create new designs, load 
backdrops, save designs, and how to generate stitches. It also explains how to measure 
distances on-screen and to turn on and off the grid on the screen. 

Working with design objects 

This section describes how to select objects using the selection tools and keyboard. It also 
shows how to hide and show the objects. It also shows how to freeze the objects. It also 
shows how to do selection using the film. 

Viewing designs 

This section explains how you can view your designs. You will learn how to zoom in/out 
of your designs. Also you will learn how to view designs in actual view. It also describes 
how to view designs by 'traveling' through the stitching sequence. Design color 
management is also explained. 

Toolbars 

This section explains various toolbars and their command buttons. This helps us to 
execute the commands directly on the screen. 

Digitizing/Punching 

This section explains various techniques and various parameters required to do punching. 

Stitch processing 

This section explains how to do various kind of stitch processing on stitch type files as 
well as on outline type files. 



General Concepts 
Following are few general things to remember before going for Evx. 
It is having following directories. 

 
C:\evx 
Root directory of the software. 
 
C:\evx\fonts 
This is Fonts directory of the Evx. 
 
C:\Evx\Design 
This directory is parent directory for designs. 
 
C:\Evx\Design\CUSTOMERCOMPANY 
This directory is for designs of Customer Company (like Galaxy, Kohinoor, 
Radnik, Rainbow, Orient, etc). 
C:\Evx\Design\Galaxy 
 
C:\Evx\Design\Galaxy\Exports 
This directory is for designs of your company of category Exports. 
. 
. 
. 
You can create any number of companies as many as you want. 

 

Punching with Evx 
Turning design in to reality was never as easy before. With the strength of Evx vector 
based objects, every complex design can be broken into a group of objects. Each object 
can be then filled with different type of stitch type based on the need of the hour. With 
general transformations and other tools we can arrive at an excellent design. By different 
colors in objects the look and feel of the entire design can be changed in minutes. 

Preparation 
Before we go for punching we need to go in a planned manner. Main points in this area 
are: 
 

Get a good artwork. 
Scan the artwork with high resolution scanner. 
Create a folder for your client. 
Do some adjustments with scanned images. 
Look for parameters to be used for the design change 
to template 
Plan the blocks of the design. 
Do punching. 



Save your design 
Generate output stitches. 

 
     

Artwork 
Artwork can be a design created on tracing paper, or an image (bitmap, PNG, gif, jpeg 
etc.).  Tracing paper can be put on a high resolution scanner and Evx can acquire a 
scanned image of the design. With the load backdrop we can put the images on to Evx 
screen, and the do punching on top of it. These images are usually called backdrops.  

Scan the artwork with high resolution scanner. 
A design has its orientation and size (width and height). We need to scan the design 
based on these factors. Some designs may be very large and in that case we need to scan 
it in parts. After scanning we need to join the parts together on the screen to get the whole 
design punched. 

Create a folder for your client. 
Create a folder for your client and save the scanned images in the directory. It is a good 
idea to have subdirectories to categorize the designs. 

Do some adjustments with scanned images. 
After scanning is over, you can load backdrops images in to your design. We may need to 
do some adjustments with scanned images. After selecting a backdrop you can do 
transformation on them to do adjustments according to your needs. 

Look for parameters to be used for the design change to template 
Evx has an advantage that it is based on templates. It means all the parameters are stored 
in the template file. We can change the parameters and save them as our new templates. 
Templates are the main source of parameters. Look for parameters to be used for the 
design and change to template. 

Plan the blocks of the design 
By looking at the design we can easily divide and conquer the design. Break the entire 
design into various small blocks. We should also check if the design is duplicated in 
some areas and in that case we need to use ‘copy and paste’ command to do design 
creation. In some cases an array of some blocks can also be found in the design, and in 
this case we only need to punch one such block and the remaining can be duplicated 
using array command. 

Do punching 
We are now read for the show.  Check the color and the type of stitch we need to punch 
and punch accordingly. 



Save your design 
Once finished and we want to take a break, we need to save the design by giving it a 
proper name. 

Generate output stitches 
Finally generate output stitches to floppy or to pen drive based on your needs. 
 
 



Working with design files 

Evx embroidery punching software is a graphical user interface (GUI) based software 
developed on MS Windows. It uses basic conventions of windows operating system to 
ease its operating. We will be explaining in this section; to open existing design, create 
new designs, load backdrops, save designs, and how to generate stitches. We will also 
explain how to measure distances on-screen and to turn on and off the grid on the screen. 

Application Startup 
You can start Evx by Gehlot IT Consultants from the desktop icon or the Windows Start 
menu. 
 
To start Evx by Gehlot IT Consultants 

 

 

 
 

Double click on Evx shortcut icon defined on Windows 
desktop to start Evx 

 
Double-click the Evx by Gehlot IT Consultants shortcut icon on the Windows desktop. 
 
Alternatively, Start menu > Programs > Gehlotitc > Evx 
 
Evx by Gehlot IT Consultants will start with new blank design document. You can now 
load a backdrop and be ready for punching a new design. 
 
Before we start, please read the commands in the following sections. 
 

 



Evx by Gehlot IT Consultants look and feel 
              

 

Command bars 
Evx by Gehlot IT Consultants is designed to have many bars to let the user fire various 
commands. 

Menu bar 
You can execute menu commands from the menu bar as shown below. 

 

Standard toolbar 
Standard toolbar is used for firing commands related to document. 

 
 

Stitch type toolbar 

Stitch Type toolbar is shown as follows: 

 

Play stitches toolbar 
Play Stitches toolbar is used for playing the stitches of the design. 

 



Object manipulation toolbar 
This toolbar is used for zooming, and various such manipulations on objects. 

 

Object position and mirror toolbar 
This toolbar is used for placing objects one after another and mirroring and rotation of 
objects. 
 

 

Color pallet 
This toolbar is used for assigning color to various objects as well as manipulating 
commands for colors. 

 

Function toolbar 
This toolbar is used for assigning various functions to objects for stitch generation. 
 

 
 

Size Toolbar 
This toolbar show the size of the design or selected objects. 
 

 

Schiffli Toolbar 

This toolbar is used for Schiffli machine functions. 
 

 

Status toolbar  
This toolbar is used to show status of various commands as well as the objects 
information. 



Sequin command pallet 
This toolbar is used for Sequin Operation. 

 

Screen operations command pallet 
This toolbar is used for operations on screen. 

Command pallet 
This toolbar is used for joining, grouping and related commands. 
 
Sequin Command Pallet Screen Command Pallet Command Pallet 

   

 
 
 



Shortcut keys 
The following table shows various keys combination to fire commands. These are called 
shortcuts keys. 

Shortcut Key Description 
A Open Transformation Property Of Selected Object. 

Ctrl + A Select All Objects. 
Alt + A Select Attached Objects Of The Selected Object. 

Shift + A Shift Selected Objects To Attached Points (If Attached). In Node Editing on canvas will resize canvas. 
Ctrl + Shift + A All The Attachments of Selected Objects Will Be Attached To Nearest Point From End Point. 
Alt + Shift + A All The Attachments of Selected Objects Will Be Attached To Nearest Point From Start Point. 

B Zoom Box 
Ctrl + B  Break Apart The Branches. 
Alt + B  Select Bunches. 

Shift + B,    Alt + Shift + B  Make a Bunch. With ALT: Make a Bunch With Touched Objects 
Ctrl + Shift + B  Break Apart The Attachments. 

C In Punching Mode Toggle Cross Hair Cursor 
Ctrl + C Copy The Selection. 
Alt + C In Node Editing Mode Curve Break The Selected Node. 

Shift + C Hide/Show Connectors. 
Ctrl +Shift + C Align Controls Horizontal And Vertical (Center) 

D Hide/Show Backdrop (Image). 
Ctrl + D Duplicate The Selection To Array. In Node Editing will duplicate the object. 
Alt + D Select All Artwork (Drawing Objects) 

Shift + D Show /Hide Artwork (Drawing Objects). 
E In play mode Select up to cursor. In Single Bezier will add reverse nearest points to reach first point. 

Ctrl + E While Object Selected Set Starting At First Node & End Point At Last Node Of Selected Objects. 
Ctrl + Alt + E While Object Selected Set Starting and End Point At First Node Of Selected Objects.  

Shift  + E In play mode Select up to cursor. Will be in this command till escape. 
Ctrl +Shift + E Extend The Last Node Of The Selected Objects To The First Node Of Its Next Object. 

F Edit Object Properties. In Dual Punching Mode, Auto Complete 
Ctrl + F Hide / Show Sequin. 
Shift + F In Node Editing: Make selected node as starting Node.  In Dual Punching Mode, Auto Complete 

G Show / Hide Grid. 
Ctrl + G Combine The Selection To Group. 
Alt + G Alter Playing speed to be double 

Ctrl + Shift + G Combine The Selection To Group Keeping them separate in the film. 
H Hide The Selected Objects. 

Ctrl + H Will Unhide All Object At Cursor position. 
Shift + H Will Unhide Canvas At Cursor position. 

Shift + Ctrl + H Align Controls Horizontal 
I Show All (Including Hidden) Objects. 

[Shift ] + Ctrl + I Select Identical Objects. With Shift Select approximate identical also 
J Join Selection At Node to Form A Single Line. In 3D Mode Toggle Jump Points. In Play Mode Find Next Function 

Ctrl + J Combine The Selection To Branches. 
Shift + J Join Single or Two Selected Objected by Line Stitch. 

K Lock The Selected Objects. 
Ctrl + K Toggle Rock (Un-Rock) The Selected Objects, While Joining. 
Shift + K Unlock All The Objects. 

Ctrl +Shift + K Toggle Rock The Selected Objects, While Joining. 
L In Play Mode, Add Sequin Lock At Current Node. 

Ctrl + L Attach Selected Objects One After Another At Last Stitch. 
Ctrl + Shift + L Attach Selected Objects One After Another. 

M Measurement Tool. While punching Dual, With Shift Will Set Satin Auto Complete Distance 
Ctrl + Shift] + M Merge Objects (All Selected Objects) To Make A Single Object. With Shift Work Like Union 

Alt + M Mirror On Line Distance To Be Set To Last Two Nodes Punched 
Shift + M Mirror On Line While Punching with single, dual, and dual sides 

N Edit Nodes / Reshape. 
Ctrl + N Create A New Design Document. 

O Draw An Ellipse. 
Ctrl + O Open An Existing Design Document. 
Shift + O Draw A Round Rectangle (Square). 

P Full Screen Preview. 



Ctrl + P Print The Current Design Document. 
Ctrl + Shift + P Mark Current Play Position 

Q Flip The Selected Object Vertically. (Mirror Y) 
Ctrl + [Shift] + Q Generate Twine Sequin Pattern from the stitches. Shift To Shift the Pattern 

Alt + Q Flip The Selected Object Horizontally. (Mirror X) 
R Repeat Previous Transformation 

Ctrl + R Route the Selected Objects. 
Alt + R Select Alternative 

Shift + R Set Rotation Angle. 
Ctrl + Shift + R Route the Selected Objects, Attach at the maximum index point. 

S Drop Sequin In Punching Mode. Toggle Sequin In Node/Stitch Editing Mode. 
Ctrl + S Save The Current Design Document. 
Alt + S Select Alternative In Line 

Ctrl +Alt + S Select Objects Within The Selected Object 
Shift + S Show Sequin in Flapped Mode 

T 3D View Within the view 
Ctrl + T Attach Together All Selected Objects. 
Shift + T Shift Together All Selected Objects. With Control Shift With Position 

U Deselect All. 
Ctrl + U [Shift] Ungroup Selected Group Of Objects. With shift will ungroup within groups 

V Show / Hide Stitches During Node Editing (Reshape). 
Ctrl + V Paste The Contents Of The Clipboard. 

Shift + Ctrl + V Align Controls Vertical 
Alt + Shift + V Toggle Start Boundary For Satin Objects. 

W Attach Selection To The Current Playing Stitch. In Punching Mode Toggle Mouse Left, Right  Mode 
Ctrl + W Fuse the Selection together. 
Alt + W Show Repeat. 

Shift + W While Playing Shift & Attach Selected Object At Current Playing Stitch. 
Ctrl + Shift + W Remove Stitches and display objects like drawing objects. 

X The Selection Will Be Zooming To 90 % Of Screen Area. In OnTheFlyRotation Mode Toggle Objects to X mirror 
Ctrl + X Cut The Selection To The Clipboard. 
Alt + X In Punching Mode Next Node Will Be A circle. 

Shift + [Alt ] X Append Mirror of object In X with Alt Mirror Left Side. In node Editing or punching mode. Also Used For Auto 
Complete Satin. 

Y In Node editing Move First Node Of the Selection To Start Point. 
In On the fly Rotation Mode  Toggle Objects to Y mirror 

Ctrl + Y Redo The Previous Command. 
Alt + Y Shift Object to Start Point. 

Shift + Y Node Editing/ Punching mode - Append Mirror of object In Y. 
Shift + ALT + Y Node Editing/ Punching mode - Append Mirror of object In Y On Top. 

Z [Shift] Zoom In, With Shift Zoom Out 
Ctrl + Z Undo The Previous Command. 
Alt + Z Half The Playing Speed 

Ctrl + Shift + Z Redo The Previous Command. 
< Snap To Point 

Shift + < Move Object Back 
Ctrl + / Add Lock at Jump Points in the design 

. [Shift] [Ctrl] Toggle Show/Hide Needle Points. With Shift Toggle Show/Hide Node Points. Toggle Show/Hide Sequin. 
0, 1 View Whole Design. Zoom By Level 1. 

Ctrl + 1, 2 Play to First, Last Stitch of the current Object 
Shift + 1 Reverse Input Points 

2 Select Just Previous Object Under the Selected Object.  
3, 4 Change Sequin to Sequin Segment 2, Toggle Sequins 

5, Ctrl +5 Hide Unselected Objects. Create New design with copy of all objects. 
Alt + 0 Rotate Selected Objects By Degree 

Alt + 1/ Alt + 2 Set Rotation Point To First/Last Point. 
Alt + 3/ Alt + 4 Set Rotation Point To Second side, Start/Last Point. 
Alt + 5/ Alt + 6 Set Rotation Point To Bottom Middle/ Top Middle Point. 
Alt + 7/ Alt + 8 Set Rotation Point To The Middle/ Top Of The Object. 

Alt + Back Space Undo.  
Back Space In Node Edition: Delete The Selected Node. In Stitch Editor (Or Dst Object): Delete The Current Stitch. 

+ Move Selection To Front. (In Array Duplicate Increase Objects) 
_ Move Selection To Back. 
- Exclude Selection. (In “On the Fly” Array Rotation, Duplicate Decrease Objects) 

Ctrl + - Move Selection To Backward. 
= Move Selection To Forward. 



Alt + Shift + Click Will start object Under Line Punched 
, Toggle snap to point 

END Move Selection To Front. 
Ctrl + END Start Playing From End. 

HOME Start Playing From Start. 
Shift + HOME Move Selection To Back. 

Delete Clear Selection. 
UP,DOWN,LEFT, RIGHT  Move The Selection Toward Arrow Keys By 1 cm, With [Ctrl] By 0.1 mm, With [Shift] 1mm. 

Shift + PGUP Add Object Previous To The Selection To Selection List. 
Shift + PGDN Add Object Next To The Selection To Selection List. 

Ctrl + Shift + UP, DOWN, 
LEFT,RIGHT,C,V,H 

Align Selection Object respectively To Top, Bottom, Left, Right, Center, Center Vertical, Horizontal 

Alt+Shift+DOWN, RIGHT Space Control respectively Top To Bottom,  Left To Right 
Alt + UP, Alt + LEFT Align Selection Object To Grid Horizontal, Grid Vertical 

ESCAPE Cancel The Current Command. 
F2/F3/F4/F5/F6 Draw method Satin/Tatami/Zigzag/Eee/Line 

F7/F8/F9/F10/F11/F12 Draw method Program/Central/Alpha/Piping/Cross Stitch/Motif.  
Shift + Alt +F2 Place On Line Parameters 

Shift + F6 Previous Pane. 
Ctrl + Ins, Shift + Ins Copy Selection To Clipboard. Paste Contents Of Clipboard. 

Tab, Shift + Tab Select Next Object, With Shift Select Previous Object. 
Shift + <, Shift + > Move Selection To Down. Move Selection To UP. 

 
1. While in node Editing and a canvas object selected, Shift and Click on cells will toggle type of fill(X to Y).  
2. Select within polygon with Shift key pressed will select all objects touching the polygon. 
3. Shift + Click on canvas button, Select cells of type of canvas button clicked on. 
4. Dbl Click ->Object filling parameters. Dbl Click + Alt->Open PM Parameters. Dbl Click+Alt+Shift ->Open Sequin Parameters. 

 

Open existing design 
 

 

 

 
Use Open (Standard toolbar) to open an existing 
design. 

 
You can open an EVX in many ways: from within the Evx application, from your file 
system, or on a local area network. Evx opens a comprehensive range of both evx type 
and ‘stitch’ type files. 
 
Warning: You cannot open an Evx file created with a later version of the software than the one 
you are currently running. 

1. Click the Open icon . 

 IMPORTANT If you don't see the Open icon , click Open on the File menu. Keyboard 

shortcut to display the Open dialog box, press CTRL+O. 



 

 

The following are the elements that are contained in the Open dialog box. 

 Look in: In the list, click a location where the file that you want to open is stored. 
Use the Look in list to move up one or more levels in the folder structure.  

 Previous folder   As you move through the folder structure in the Files list, 
this button enables you to go back to the previous folder that you viewed.  

 Up one level   Click this button to look  

Create a new folder  

Folders are a convenient way of storing and organizing files on your computer. For 
example, you'll probably want to create folders within the Documents and Pictures 
folders to help you manage your files. You can create any number of folders and even 
store folders inside other folders. Folders located inside other folders are often called 
subfolders. 



1. After we press  a new sub-folder in the current folder is created. Type a name 
for the new folder, and then press ENTER. 

The new folder you created appears in the location you specified. 

Tip 

 You can reduce the number of folders you need to create if you learn how to find 
and organize your files using saved searches instead. 

View menu  to change thumbnail size and file details 

You can change the size and appearance of your file and folder icons by using the Views 
menu, which is located on the toolbar within every folder. 

1. Click the arrow next to views on the toolbar. 

2. Move the slider up or down to change the appearance of the icons. 

The slider has seven rest positions: Tiles, Details, List, Small Icons, Medium 
Icons, Large Icons, and Extra Large Icons. You can move the slider to any of 
these positions, or fine-tune the size of the icons by moving the slider to any point 
between these positions. 

The Views menu 

 

Tip 

To quickly switch between views, click Views on the toolbar. Each time you 
click, the folder switches to one of these four views: List, Details, Tiles, and 
Large Icons. 

 

You can perform an action (such as copying, moving, or deleting) on more than 

one file at a time, as long as all of the files are located in the same folder. 



To select nonadjacent files in the Open dialog box, click one file, hold down 

CTRL, and then click each additional file.  

To select adjacent files in the Open dialog box, click the first file in the sequence, 

hold down SHIFT, and then click the last file.  

Tip:  If you select a file that you don't want, hold down CTRL, and then click the 

file again. 

All the selected files from the "File list" are written in the "File name" field. In case a 
single file is selected a preview in the bottom of the dialog box also appears. We can type 
in this field the name of the files that are of interest and press the "Open" button to open 
the files. 
 
The "Files of types" field is used to filter out our selection for the type of embroidery 
files that will be visible in the "File list" area.  
 
Design Info: 
Evx provides additional information about the selected design on the bottom side of the 
dialog box. Additional Information about the design displayed are; Dimensions (width 
and height), “number of stitches” and “number of sequins”. More information for the 
selected design can be found with the "File->Summary Info..." option. 
 
Additionally you can call the “Evx-Explorer” of the designs to get the thumbnail view of 
the designs. 



Create new designs 
When you start Evx, a new file—untitled1—is automatically created, ready for you to 
start digitizing. By default, Design1 is based on the Normal template. Templates are 
available in template directory in the root (installation directory) of Evx. These design 
documents contain default setting for various stitch types. These also contain pre 
designed styles and patterns. We can change the default template in File->Preference 
option. 
 
We can also create a new design by clicking on the “New” icon available on standard 
toolbar or select the option "File->New" or press “Ctrl + N” shortcut key. 
 

Tip Whenever you create a new design, save it with a new name. 

Design size 
A rectangle appearing in the new design shows the dimensions of the design. You can 
select the rectangle and change its size to actual design size of your interest. This 
rectangle is just a guideline to show that your objects fall within the boundary of the 
design. 

Backdrop 
Scan the design and save as JPEG format, in the working directory say (C:\ Evx\Design\ 
Anand\images). File->load backdrop will open dialog box for opening an image file. 
Select the image file and click open, this will open the image as backdrop. 

Load backdrops 
We can load backdrops from Menu command “File->Load Backdrop”. File Dialog will 
appear in the same manner as we have seen in File->Open dialog. Basic functionality is 
same except for the type of files. Once finished with the backdrop selection, click “Open” 
to continue. 
 
After Backdrops are loaded we can do transformation on them to adjust their dimensions 
(“width” and “height”). 

 



 

Hide backdrop 
Press B to toggle backdrop show/hide. You can also toggle it from File>Show/Hide 
Backdrop. 

Remove backdrop 
First make sure that “Allow backdrop selection” is checked. 



 
Now browse the film and select the desired backdrop in the film and press <del> key to 
delete the backdrop. 
Selected backdrop will be removed from your design. 
 
Note: There is no undo command for backdrops. You need to load backdrop again to 
insert backdrop into your design. 

Save designs 
 

 
 

Use Save (Standard toolbar) to save the current design. 
 
Evx saves designs in Evx and ‘stitch’ files format. A special interface is provided to 
generate stitches. Designs are saved in folders with a file name and its extension. Opened 
designs, when saved are overwritten. To save separately use “Save As” option from the 
“File>Save As”. A copy of the design can be made by shortcut key “ctrl + 5”. 



To save a design 

1. Click the Save icon . 
If this is the first time you have saved the design, the Save As dialog opens. 
 

 
 
2. Select the folder where you want to save the design from the Save In list. 
3. Enter a name for the design in the File name field. 

a. If you click on a file already there, its preview along with other design information 
will be displayed, and its name will be automatically copied to file name.  

4. Select a file format from the Save as type list. 
5. You can also select previous version to save the design. Previous versions from 2.4 
onward are supported. 
 
Warning If you are saving a file to “stitch” file format, it will loss all object properties. 
 
 
6. Click Save. 
 
Tip Once you have saved a design, and made changes to it, then every time you click 
Save on the toolbar the file will be updated. 



Evx - Explorer 

Evx-Explorer works like Windows explorer and it helps us to manage designs in folders. 
Powerful features like displaying various designs, sorting design information, increased 
productivity etc. are available. On the fly selection, opening, deleting and moving various 
deigns makes life as simple as never before. Thumbnail view of designs in small and big 
icon with instant display makes the designer able to choose designs from various folders 
in seconds. Thumbnails are zoomed to user defined size making another dent in the way. 
On the fly printing is another big hit by this technology in the market.  

To display Evx-Explorer 

1 Click the Evx Design Explorer icon.  

IMPORTANT If you don't see the Evx Design Explorer icon , click Design Explorer on the File 

menu. 

Evx Design Explore elements 
The following are the elements that are contained in the Evx-Explorer. 

 Folder list pan Right hand side pan in exp-explorer shows structure of the folders 
and the subfolders of your hard disk. If you click on a location where the files that 
you want to display are stored, files will be displayed in the preview pan. If you 
click on “+” symbol in front of folder you can see the subfolders of the folder. 
Use the Folder list to move up one or more levels in the folder structure.  
 
You can also use explorer to see any design contained in a network computer. 
 

 Preview pan Right hand side pan is the preview pan which is the view area and 
files lists are displayed here. 

 Very large Icon Left hand side bottom pan is the area for displaying icons in a 
large size. 

 
 

 



Browse folders 
A "+" symbol on the left hand side of a folder indicates it has subfolders and we can 
expand them by clicking on the "+" button. The “+” symbol will become “-“ symbol,  and 
a list of folders in the exploded folder will appear. In the same way we can collapse the 
folder by pressing the "-" on the left side of the subfolder, and a “+” symbol will appear 
in front of the collapsed folder. 

If you select a folder the file list will be displayed in the Preview pan. 

 



 
 
 
View menu to change thumbnail size and file details 

You can change the size and appearance of your file and folder icons by using the views 
context menu, which is invoked by pressing the right mouse button on the preview file 
list pan. 



 

Click on the option in the context menu to change the appearance of the explorer file list 
view. 

The menu items are: Open, Select all, Exclude Selection, Choose Selection, Large 
Icon, Small Icon, Detail, Delete, Rename, Toggle Design Info, Refresh path and 
Toggle filter; Evx files, All design files, and stitch files only. 

The Views small icons 



 

 

Selection in Evx-Explorer 
To select any design in evx-explorer, click on the thumbnail in front of it. We can select 
more designs by holding "Ctrl" key and then clicking on the designs. We can also drag a 
click on the preview pan and all the designs inside the traced rectangle will be selected. 
 
We can also do select by other commands: 

Design selection 
Design Selection is made with the following Icons: 
 

 
All Select All the designs on the screen.  

 
Unselect Unselect all the designs. 

 
Negate 
Selection 

Unselect the selection and select the unselected design on the screen. 

 
Choose 
Selection 

Provide a temporary filter for selection and deselecting of designs. 



 
 

To open designs 
In order to open the designs, first complete our selection and right click on your selected 
design, invoke the Open menu command. All deigns will be opened and ready for 
operations. 

To view design information 
Design information can be seen in the detail view of the Evx-Explorer. This can be 
invoked by context menu and clicking on “Detail” menu. 
 

 
 

Name Name of the design file as provided by windows operations system.

Size Size of the file in bytes as provided by windows operations system. 

Date Date of design file as provided by windows operations system. 

Width Width of the design as calculated by Evx. 

Height Height of the design as calculated by Evx. 

Color Colors in the design as per Evx. 

Stitches Number of stitches in the design as calculated by Evx. 

Type Type of file as evx, DST etc. 



To delete design 
Lets us first select the design we want to delete and then press the “Delete” button from 
the keyboard. 
 
We can also invoke “Delete” from context menu. 
 

To Toggle Design Info 
You can suppress design info on the icon so that these are visible clearly. 

To filter file type 
Evx-Explorer can show all type of supported files in the preview pan. We can invoke file 
type form context menu “Toggle Filter”. Possible types are “*.evx”, stitch type files*.dst, 
*.DSB etc”, both “stitch types” and “evx type”. 

Auto-backup and recovery mechanism 
Evx has one of the most powerful features to avoid losing your data in the event of a 
system hang or system crash.  
 
Auto-backup:  This feature saves our designs after every change we make in the designs. 
If a design is saved it will be removed from the auto-backup, until you again make some 
changes to it. In most cases you will not lose your design. 
 
Auto-Recovery:  This feature recovers our design the next time we open Evx. These 
designs were saved by auto-backup feature of evx in an auto backup area. If the system 
hangs in auto-recovery mode, start evx again. It will filter the design on which it has 
hanged and continue recovery of rest of the designs. 
 
Note: It is a good policy to save designs frequently. 

Format a floppy diskette 
 

File>Format 
Floppy 

 
Use File>Format Floppy to format a diskette. 

 
We can format a diskette by “File>Format floppy” command. All the design files will be 
deleted and full area of the diskette can be used after formatting a diskette. 

To format a Diskette 

1 First of all insert a diskette in the floppy disk drive. Also make sure from 
“File>Preference” that floppy drive to choose for format matches with our drive “A” 
or “B”. 

2 In the “format disk properties” field of the "Floppy disk format" function you can 
select the type of the machine disk that you are going to create. 

3 Press "Format" button to format the floppy. 
4 Evx will try to recognize the current floppy diskette format. 



 
If the diskette that you have inserted is already formatted and have same type, Evx will 
ask to do a quick format to save time. We can select to do quick or full formatting at this 
time. 

Write disk 
 

  Use Write disk (Standard toolbar) to save the current design on to a 
floppy drive. 

 
Embroidery m/c recognizes stitch type files. Once our designs are ready, we can write 
stitches on to diskette.  

To write diskette 

Take a formatted diskette and place it inside the drive and then click on  button. Evx 
recognizes the format of the diskette and reads its directory structure. After reading the 
structure it will display all the files in the list box. 
 
Note: If you have forgotten to put the diskette in the drive, Evx will prompt for retry or 
cancel. 



 
 
Design name: This is the internal file name of the design which is sometimes used to 
display on embroidery m/c. 
 
Filename: This is the file name of the design in the directory structure. File names are 
generated by default in the form of Gxxx.dst. Evx generates next file names by 
incrementing the number by one. If you check same file name checkbox, these numbers 
will not be generated, rather the design file name will be copied to this field. 
 
Same file name: This checkbox is used to say that file name should be same as the 
design file name. 
 
File List: Under this field you can see the designs that are already in the diskette. 

Delete the designs 
We can delete the designs from the diskette to empty the space on it. 



Warning: Designs once deleted cannot be recovered, so before deleting make sure you 
have backup of it. 

To delete the design 
Select the design files from the file list. You can select them by clicking on the filename. 
For multiple selections you click and drag the mouse. You can also use ctrl key to hold 
the selection and add/remove any single selection. 

Colors 
Evx Colors are helpful in separating objects from each other. Evx help its users to define 
various colors for tools and objects as show the figure bellow. Objects selected by default 
shown in reverse color of desktop. Check “Must Use Selection Color” to use user defined 
selection color. 

 
 

Measuring distance on-screen 
Evx understands our needs and hence cultivated features like this one never before. 
Measurement set consists of distance dX in x axes; distance dY in y axes, a point to point 
distance d, and angle of rotation A in degree. All distances are in millimeters mm and is 
the distance between two points on the screen. Measurements are not affected by the 
zooming factor. 



 
Tip For more accurate results, zoom in before you measure. 
 
To measure a distance on-screen 

1 Select Tools > Measurement tool or press M. 
2 Click on the screen at the start point. 
3 Move the mouse 

The measurements are displayed in the measurements rectangle as shown below: 
 

 


4 Press right mouse button or Esc to finish. 
The measurements tool also used to perform “On the fly transformations”: 

1. Select objects to be transformed. 
2. Press M to start the measurement. 
3. Move the mouse toward you want to move the selected objects. 
4. While measurements are on press <Enter> Key to fix the transformation. 
5. Move the mouse to a point where you want to create transformation objects. 
6. Press “R” key. The selected objects will be duplicated to the number of time 

(defined in application properties). 

Displaying grid, rulers and guides 
Evx provides grid lines on the screen to allow accurate positioning of the design objects. 
Evx also provides horizontal and vertical rulers on the screen to allow accurate 
positioning of the mouse position and hence the objects. It also helps us to see the design 
size. Evx also provides guide lines on the screen to allow accurate positioning of the node 
points as well as object’s position. 

Displaying Grid 
We can show or hide the grid at any time. Default grid spacing is 10 mm x 10 mm. We 
can change the size of the grid as well as the color of the grid lines View> Grid size: 



 

Size –X Horizontal 

In this area you can enter the distance between grid lines for the 'X' axis. The distance 
must be entered in millimeters. 

Size –Y Horizontal 

In this area you can enter the distance between grid lines for the 'Y' axis. The distance 
must be entered in millimeters. 

Set Color 
We can change the color of the grid lines by clicking on this button. A color dialog will 
appear and we can choose the color from it. 

To display the grid 
Grids are Toggle by shortcut key G or alternatively Select View > Grid. 

Displaying rulers 

Rulers are measured in mm and are located to the top (for horizontal ruler) and left (for 
vertical ruler) side of the design window. The ruler scale, illustrated with numbers and 
ticks, depends on the zoom setting. Rulers are displayed on the top of images but under 
embroidery objects. 

To display the rulers 
Show or hide rulers can be performed by View>Horizontal ruler and View>Vertical 
ruler. 



Displaying guides 
Guides are dotted vertical and horizontal lines placed across the design window to help 
you align objects. Each guide has a rectangular shape on the window and can be dragged 
on the screen to move it around. 
 
Guides are always displayed ‘on top’ of the grid and all images, and beneath embroidery 
objects. 

To create the Guides 

Rulers must be displayed before a guide can be created.  

Click on either ruler (horizontal or vertical) and drag on to design window. A guide will 
be attached to the mouse’s current position. Move to the suitable position and release the 
mouse after reaching the point where you want to put a guide. You can select a guide by 
clicking on it and dragging it to the place at another position. 

Delete a guide 

A guide can be removed by selecting it and by pressing delete (Del) key. 

Note: Guides are stored along with the deign file and they are preserved. 

Design Information 
 

File>Summary 
Info… 

Use File>Summary info… command to invoke 
design information. 

 
Evx provides a mechanism to store information of designs according to the user 
requirements. It makes a big difference when it also provides information about thread 
calculation based on user parameters and a lot more. 

To display design Information 
1 Click Summary Info… on the File menu. 



 
 
Summary elements 
The following are the elements that are contained in the Summary information. 

Customer: Name of the customer of the design. 
Artist: Name of the artist of the design. 
Punch: Name of the digitizer of the design 
Keyword: Keyword of the design. 
Comments: Any comments about the design. 
Also See: Also see filed of the design 



 
 

Thread information elements 
The following are the elements that are contained in the Thread information. 

Yarn: Color wise thread used in the design. 
Export file name: Name of the file for exporting yarn information of the design. 
Export to File: Command button for exporting yarn information of the design. 
Colors: Number of colors used in the design. 
Bobbin: Bobbin thread used for the design. 
Yarn: Yarn thread used for the design. 
Stitches: Number of stitches in the design. 
Fabric thickness: Input parameter for calculation of thread used for the design. 
Bobbin tension: Input parameter for calculation of thread used for the design. 
Copy to summary comments: This command will append Yarn information to 
“Comment” filed in the “Summary” Tab. 



Working with design objects 

There are many ways to select and deselect various objects in the design. 

Selection 
First of all select selection tool (  ) for performing selection. Objects created are selected 
by either clicking on them or by dragging the mouse to form a rectangle. Selection is also 
possible by film icons (See film icons). 
 
Note:  Shift + > will add next object to the selected list and Shift + < will add 
previous element to the selected list. 

Point selection 

Point selection Icon ( ) is used to toggle points selection. During this mode you can 
select multiple nodes of the selected object. When we are moving, all nodes are moved 
together. 

Selecting input methods 
Selection input methods are 

Mouse and keyword commands 

Menu commands 

Selection through film 

Selection for color and stitch types 

Selection in play mode 

Select using mouse and keyword 
Mouse and keyword are most convenient methods to select various objects or the whole 
design. Let us first discuss some terms before we continue. 

Rubber band 
Click the mouse and drag it on the screen to draw a rectangle. This rectangle is called the 
rubber band and if we release the mouse this rectangle disappears. 

 



 
 

Tracker and tracker points 
Selected objects are bound by the rectangle which is called Tracker. There are eight small 
rectangles on the boundary of this rectangle and are called tracker points. These are also 
called handles and help us to do resizing and rotating objects. These handles become 
rotation points when we click on the selected objects. If we click again on the selected 
objects these handles come in resizing mode. 

 

 
 

To select objects by pointing & clicking 
Click on the object you want to select. As shown above, trackers will appear around it. 
Moving to another object and clicking on it will deselect the previous object and will 
select the object clicked. To select both the objects click on the first object, hold down 
Ctrl and click on the other object. 

 



   
 

To rubber band selection 
Click and drag the mouse on the objects we want to select. Make sure all the object falls 
within the rubber band.  All of the objects that are completely within the rubber band will 
be selected. When selecting objects, if you hold the "Shift" key you can add or remove 
items from the selection. Similarly if you hold "Ctrl" key you can simply add or remove 
items from the selection by clicking on the objects. 

To select objects with Polygon Select 

1 Click the Polygon Select icon. 
2 Draw a polygon around the object/s you want to select. 
3 Click right mouse button 

 
All the objects completely within the polygon outline will be selected. 

To keyword selection 
We can use keyword shortcut keys as well as Icons on the selection toolbar as well as 
from Edit menu to do selection. 
 

 
Select 
All 

Ctrl + A 
Select All the objects on the screen. Hidden objects, fixed objects, backdrops 
and user guide objects are not selected. 

 
Unselect U Unselect all the objects. 

 
Negate 
Selection 

  
Unselect the selection and select the unselected objects on the screen. 
Hidden objects, fixed objects, backdrops and user guide objects are not 
selected. 

 

Select 
Next 
Object 

<TAB> Select next object after the current selection 

 

Select 
Previous 
Object 

<Shift> 
+<TAB> 

Select previous object before the current selection 

 
  Used for single select 



Selection all 
You can select all the objects on the canvas by pressing CTRL + A, alternatively you can 

also press selection all icon ( ) to selection all objects. 

Exclude selection 
With this option we exclude the selected objects and include the unselected objects. 

Invoke exclude selection icon ( ) to perform exclude.  

Clear selection 

Press clear selection icon ( ) to clear the selection list. This is required when you want 
to see the flow (see space) of the machine. 

TAB 

Pressing <TAB> or clicking on the Tab Icon ( ) will select the next object. Pressing 

Shift + <TAB> or clicking on the Shift Tab Icon ( ) will select the previous object. 
Note: CTRL + TAB will go to next design. 

Keep on single select 
This is a good feature for editing and polishing objects one by one. Press Keep on Single 

Select Icon ( ) to toggle this feature. Now pressing <TAB> or clicking on the Tab 

Icon ( ) will hide the current object and select the next object and will enlarge it to 

the whole screen. Similarly the Shift Tab Icon ( ) will show the previous object.  

Arrow keys 
Arrow keys are used to move the selection on the canvas. Selected objects are moved by 
1cm. By pressing the CTRL Key, selected objects are moved by 0.1mm. By pressing the 
SHIFT Key, selected objects are moved by 1 mm.  
When Points Selection is on, only the nodes move, not the entire object. 
When nothing is selected design is scrolled. 

+- 
If any object is selected and + is pressed it will push the object towards the end of the 
document. If any object is selected and - is pressed it will push the object towards the 
beginning of the document. 
 
CTRL + + will bring the object to the end of the design, and CTRL + - will bring the 
object to the beginning of the design. 
 



To do selection through film 
Film icon shows the objects created in a sequential way (one after another) in the 
filmstrip . Clicking on any object in the film will select the object. Shift +click will 
select all objects from the First or Last selection depending upon the clicked position. 
CTRL + click will toggle the object selection. Double clicking on any object will display 
the object in its view by focusing on it. 
 
Film is actually one of the convenient methods to do selection. Scroll the film and click 
on the object icon to do selection. For range selection click on first object and then hold 
down Shift key and click on the second object. All objects between the two objects will 
be selected. We can use CTRL key to remove or add single objects by clicking on them 
in the film. 

 

 
 

Note: When you click on the object in the view window, film will scroll to show the 
clicked object. 

Shift objects through Film 
We can shift the object using film either through drag or by selecting a position as 
follows. 

Drag method 
First of all select the objects you want and drag on the film to move to a specified 
location. 

Position method 
First of all select the objects you want to move to a specified location, right click on the 
film, a menu “Add selection to Position” is opened, click on it. 

 

 
 

Enter the position where you want to move all the selected objects and press OK. 



 

 
 

To do Selection for color and stitch types 
Color: Selection is made easy for colors in Evx. 
With <SHIFT> key pressed clicking on any color will select that color. 
Right click on the color in the color pallet to do the selection operation for the color. 

 

 
 

Selection by multiple colors is invoked from “View > Select by colors”. We can drag on 
the colors to do selection for various colors.  

 



 
 

Stitch type: Selection by stitch type is invoked from “View>Select by stitch type”. We 
can drag on the stitch types to do selection for various types. 

 

 
 



To do selection in play mode 
Play unto stitches and click on “Selection Current”. Evx will select the object being 
played. 

Deselecting objects 
We can easily remove all objects or individual objects from the selection.   

To deselect objects 

1 We can deselect all objects just by pressing U. 
2 We can also click on an empty area of the design to do this operation. 
3 Select View > Deselect All to deselect all objects. 
4 Individual objects can be removed from the selection by holding down Ctrl and 

clicking on the object to deselect. 



 Reposition 
Objects can be repositioned on the screen through keyboard commands according to the 
following Icons: 

 

 
Front Move the object to the front of the document 

 
Back Move the object to the back of the document 

 
Next Move the object to next position in z-order of the document 

 
Previous 

Move the object to previous position in z-order of the 
document 

 

Hide object 

Hide Object Tool Icon ( ) will hide the selected objects from the canvas.  

Hide remaining 
Select the only objects you want to keep on the canvas and press hide remaining tool 

Icon . 

Unhide all object 

To unhide press unhide all tool Icon (  ). All the objects will be shown on the canvas. 

Start end point of the object 
Start end point for an individual object can be set as follows: 

Object start point. 
Each block is having a starting point. This is the point where the first stitch will start. 

Press the start point icon  and click where you want the end point of the block. 

Object end point. 
Each block is having an ending point. This is the point where intelligent fill will end after 
filling the object. Press the end point icon  and click where you want to make the end 
point of the block. 

Set starting point/end point of the design 
Each Design is auto center for the starting point. Change from Edit-> Set Stating point. 

 



 

To Set starting point 
 

 
 

You can click and then double click the point where you want the starting point. Press 
<ESC> to set the starting point as center of the design. 



Set starting point to auto 

 
 

Enter your choice and press OK to set the starting point options. Normally we set bottom 
right as starting point because of machine pantograph. 
We can also digitize the starting point of the design. Once design starting or ending point 
set it will fixed. 
 
Note: You can, in the same manner, set the ending point of the design. 

Rotate the object 

Right click on Icon ( ) to set the parameter for rotation.  
 



 
 

Select a single object and move its center point for rotation position and press ( ). 
 

 

Transformations 
You can do a lot of transformations on the selected objects. Select an object and press A 
to do the transformations. 

 



 
 

Viewing designs 

We have completed explaining how to select various objects in the design; next step is to 
go deep into designing objects. Some objects are very large and some are very small. Evx 
understands the need of the punchers, and provides zooming feature. Beside that Evx also 
provides features like actual view and also has the mechanism to see how the design will 
travel stitch by stitch. Evx color management helps its users to see designs with the colors 
of their choice. Hiding objects helps Evx users to hide the finished objects and 
concentrate on new objects. 

Zoom 
Zoom input methods are 
 

Mouse and keyword commands 

Menu commands 

Toolbar Icon 



Zoom using mouse and keyword 

Mouse and keyword are most convenient methods to do zooming in the design. Every 
time we perform a zoom operation its current zoom is preserved. It means that we can go 
back to previous zoom position after a zoom operation. Zooming does not change the 
object or design properties and hence zoom operations are not part of undo/redo 
operations. Let us first discuss some terms before we continue. 

Rubber band 
Click the mouse and drag it on the screen to draw a rectangle. This rectangle is called a 
rubber band and if we release the mouse this rectangle disappears. 

To zoom to previous zoom 
Zoom to previous zoom is provided in context menu. If we have performed a zoom 
operation, just double clicking the right mouse button will take us to the previous 
zooming position. 

Zooming in/out using mouse 
1. Click the right mouse button in the area of your interest and release it to start 

zoom in operation. 
2. Press the left button and drag the mouse to the zoom area and release the mouse to 

zoom in the dragged area. 
 
Note: Double click right button will bring us to previous zoom position. 

Zooming in/out using keyboard 
1. Shortcut key “Z” command will do zoom in operation in the design. 
2. Shortcut keys “Shift + Z” command will do zoom out operation in the design. 

Zooming in/out using menu 
Zoom in and zoom out operations can also be performed from View>Zoom in and 
View>Zoom out menu commands. 

To zoom using Icons 
Zooming is available with the following Icons: 
 

 
Zoom in 

This tool allows you to zoom into the design 
document. 

 
Zoom out 

This tool allows you to zoom out of the design 
document. 

 
Zoom actual 

This tool allows you to zoom to the actual size of 
the design document. 

 
Zoom selection 
to maximum 

This tool allows you to zoom in the selection to 
screen size. 



 
Zoom selection 
to 90% 

This tool allows you to zoom in the selection to 
90% size of the screen size. 

Full screen view 

Full screen view or stitch preview Icon ( ) is used to show the stitches in the whole 
screen. You can click the mouse or Key ‘P’ to go back to normal view. 

 

 
 

Whole design view 

Whole design view Icon ( ) is used to show the whole design on the screen. It will try 
to zoom in/out to fit the design on the whole screen. 

Show Repeat (Show head to head) 
This command display the entire design repeated for second and subsequent heads on the 
screen. Show Head to Head parameters are shown in the following dialog box:  

 
 



 

To Show repeat 

1. Show repeat is a toggle command on how to show repeat icon ( ). Shortcut 
key is ALT + w. 

 
Middle portion of the above picture is the design with its original attributes. First 
and last portions are with the color changes and depict that these are made with 
other heads. 



Toolbars 
In this section we will discuss the toolbar commands. The toolbars are displayed on the 
screen and there buttons are ready to accept commands. In this way, just by clicking on 
the toolbar button, we can execute commands immediately. In case a button is grey out, it 
means the command is disabled for selected objects or the entire design. The commands 
are enabled or disabled based on the selection criteria. 

Standard toolbar command 
Standard toolbar is a tool for windows commands. 

 
Standard Toolbar has the following buttons: 

 New 
By pressing New Icon you can create a new design document.  When 
you create a new design, save it with a new name. See Saving designs 
for details. 

 Open By pressing this button you can load an existing design document. 

 Save 

By pressing this button you can save the current design document. In 
case the design document was never saved before, the program 
automatically calls the "Save as" dialog. 
 
To save a document in a different location or format, use the save as 
procedure below. 

 Recent files By pressing this button you can open most recent files. 

 Import File By pressing this button you can import files of different formats. 

 
Write Disk 

By pressing this button you can generate the stitches in the dst format 
on the selected floppy location. 

 
Cut 

Removes selected data from the document and stores it on the 
clipboard. 

 
Copy Copies the selection to the clipboard. 

 
Past Inserts the contents of the clipboard at the insertion point. 

 
Print Prints the active document. 

 Print preview Print previews the active document. 

 
Content 
Sensitive 

Content Sensitive help 

 Undo By pressing this button, you rollback the previous action on the 



document. 

 Redo By pressing this button, you reapply the previous undo command. 

 Evx-Explorer Launch Evx-Explorer to view the thumbnail of designs. 

 Film Toggle the film 

 Lock Toggle the lock stitches.  

 User Lock User defined locks while Branching (Joining). 

 
Node 
Selection 

Toggle the node selection. When this option is on, you can select 
multiple node points of the object and then drag to reshape them. 

 
Fix Start End 
Point 

Fix Start point at first node position and End Point at last node 
position in the global setting.  

 
Fix Start End 
Point 

Fix Start point and End Point at first node position in the global 
setting.  

 
Toggle 
Drawing 

Toggle drawing object shape of the outlines. 

 
Fix Start End 
Point 

Fix Start point and End Point at first node position of the selected 
objects. 

 
Fix Start End 
Point 

Fix Start point at first node position and End Point at last node 
position of the selected objects. 

 
Remove Start 
Point 

Remove Start Point of the selection. 

 
Remove End 
Point 

Remove the end point of the selection. 

 Selection 
This is selection tool. When on, you can select various objects on the canvas 
to move them around. 

 
Snap To Point While punching snap to the point on which you are moving the mouse.

 
Mannual 
Stitch 

Punched line object will be filled with manual stitching. 

Block tools 
There are many drawing block tools to construct a block. A block so made can be filled 
later on with any type of fill. 

 
 

 
Single 

Single tool allows you to create a single Bezier outline. This outline is 
usually used for filling Tatami in the closed area. 



 
Dual 

This tool allows you to create two outlines side by side with direction of fill 
attached to each node point. This is used to fill satin. 

 
Dual 
Sides 

Punch first side and then Other side of the object. 

 
Append Append the selected object to add more nodes to it. 

 

Show 
Design 
Info 

Show Design Information, design stitch, thread used etc. 

 

User 
defined 
Center 
point 

Used in star fill to move the center point of the object. 

 
Zoom 
size 

This is the zoom size of the design. 

 

Fill types tool 
Following Fill type toolbar is used for creating various types of fills inside the outlines. 

 
 

 General This tool allows you to change general parameters of Objects. 

 Sequin This tool allows you to change sequin parameters of Objects. 

 
Satin 

This tool allows you to create a Satin fill for the outline. If the outline is a 
single outline it will be filled with Satin with the fixed direction defined for 
direction of fill. 

 
Tatami 

This tool allows you to create a Tatami fill for the outline. If the outline is a 
single outline it will be filled with Tatami with the fixed direction defined 
for direction of fill. 

 
Zigzag 

This tool allows you to create a Zigzag fill for the outline. If the outline is a 
single outline it will be filled with Zigzag with the fixed direction defined 
for direction of fill. In case of outline ellipse, it will be filled with star-like 
stitches. 

 Star Fill 
This tool allows you to create a Star type fill for the circular objects. It will 
be filled with star-like stitches. 

 E-fill 
This tool allows you to create an E-Fill fill for the outline. If the outline is a 
single outline it will be filled with E-Fill with the fixed direction defined for 
direction of fill. 

 
Line This tool allows you to create a Line fill for the outline. Line fill optionally 



has the parameter to fill as manual fill. 

 
Central 

This tool will create two outlines of the single punched outline. These virtual 
outlines will be used to create the desired fill. 

 
Alpha This tool is used to create alphabets fill on the outline punched. 

 Program 
This tool allows you to create a Program fill for the outline. If the outline is 
a single outline it will be filled with Program with the fixed direction 
defined for direction of fill. 

 Piping This tool is used to create piping fill on the outline punched. 

 
Cross 
Stitch 

This tool is used to create Cross stitch fill on the outline punched. 

 
Motif 

This tool allows you to create a Motif fill for the outline. If the outline is a 
single outline it will be filled with Motif with the fixed direction defined for 
direction of fill. 

 Ripple This tool is used to create Ripple fill on the outline punched. 

 Water fill This tool is used to create water fill impression on the outline punched. 

 
Jall Fill This tool is used to create Jall fill on the outline punched. 

 
Stipple This tool is used to create Stipple fill on the outline punched. 

 
Underlay This tool is used to put additional pre fills to the design called underlay. 

 

Show 
Head to 
Head 

This tool shows the design repeated for second and subsequent heads. 

 
On the Fly 
Rotation  

This tool allows the objects to rotate about the mouse point. Press + - to 
increase no of copies to increase or decrease. 

 
On the Fly 
Array Fill 

This tool allows the objects to Place in the array to the mouse point. Press + 
- to increase no of copies to increase or decrease toward X side. Shift +- will 
increase/decrease towards Y side. 

 
On  The 
fly Satin 

This tool allows the objects to create a satin object from a line object around 
a circle created on the fly about the mouse point. 

 Rotation This tool allows the objects to rotate about the rotation point. 

 
Add 
Border 

This tool allows the user to add a border around the selected objects. 

 
Input Start 
Point  

Input the start point of the selected object with mouse. 

 
Input End 
Point  

Input the end point of the selected object with mouse. 



 Properties 
This tool allows the user to set selected objects as hole, stop line objects, 
Ripple edge, pattern etc. 

 
Place On 
line 

Place On line tool allow the user to place the objects on a line. Rename the 
line object with –N N=1,2,3 etc. Select other objects to be placed, and click 
this object. 

 
Spiral 
parameters 

Change the parameters of the spiral object. 

 
Show 
Arrai 

Show Arrai, doorri, coiling for objects. 

Play mode 
Following play mode toolbar is used for traveling stitches of the design. Home key can be 
used to start the first stitch. Pg-up and pg-dn keys can be used to goto next color or 
previous color of the design. 

 
 

 
Traveling/Pausing 
Stitch 

This tool allows you to traveling/pausing the stitches on the screen 

 
Skip To previous 
Object 

This tool allows you to travel to previous available object. 

 
Skip To Next 
Color 

This tool allows you to travel to next available color. 

 
One Stitch 
forward 

This tool allows you to travel one Stitch forward till you release the 
mouse and keep the mouse position on same icon used to travel 
stitches one by one 

 
Ten Stitch 
forward 

This tool allows you to travel Ten Stitches forward till you release 
the mouse and keep the mouse position on same icon used to travel 
stitches Ten by Ten 

 

Thousand Stitch 
forward 

This tool allows you to travel Thousand Stitches forward till you 
release the mouse and keep the mouse position on same icon used 
to travel stitches Thousand by Thousand 

 
Reverse Direction Same as above but in reverse directions. 

 

Skip To previous 
Color 

This tool allows you to travel to previous available color. 

 
Skip To previous 
Object 

This tool allows you to travel to previous available object. 

 
Travel to last 
stitch 

This tool allows you to travel to Travel to last stitch of the design. 



 
Exit Travelling 

This tool allows you to Exit Travelling. You can press <ESC> to 
this operation. 

 

Zoom 
Zooming is available with the following Icons: 

 
 

 
Full screen 
view 

Stitch preview Icon is used to show the stitches in the whole screen. You can 
click the mouse or Key ‘P’ to go back to normal view. 

 

View 
Whole 
Design 

This tool allows you to view whole design on the screen. 

 
Zoom me  
in Fill 

This tool allows you to zoom in the selection on whole screen. 

 

Zoom 
Selection 
to 90% 

This tool allows you to zoom in the selection to 90% size of the screen size. 

 
Zoom in This tool allows you to zoom into the design document. 

 
Zoom out This tool allows you to zoom out of the design document. 

 
Zoom 
actual 

This tool allows you to zoom to the actual size of the design document. 

 
Zoom 
Mode 

This tool allows you to start zoom the design document. 

Reposition 
Objects can be repositioned on the screen through keyboard commands using the 
following Icons: 

 

 
Front Move the object to the front of the document 

 
Back Move the object to the back of the document 

 
Next Move the object to the next position in z-order of the document 

 
Previous Move the object to the previous position in z-order of the document 

 
Mirror 
Horizontal 

Mirror the selected objects to Mirror Horizontally (Shortcut key being Q) 



 
Mirror 
Vertical 

Mirror the selected objects to Mirror Vertically (Shortcut key being ALT + 
Q) 

 
Mirror At 
Line 

Mirror the selected objects to a line. If clicked on two nodes drawing object, 
All selected objects will be mirrored on drawing object. This is very helpful 
in mirroring the design.    

 

Rotate 45 
degree 
Anti 
Clockwise 

This command will Rotate 45 degree Anti Clock, all the selected objects 

 

Rotate 45 
degree 
Clockwise 

This command will Rotate 45 degree clockwise, all the selected objects 

 
Rotate 
Object 

This command will Rotate all the selected objects by degree set in the 
parameters of rotate. 

 

Object selection 
Objects Selection is made easy with the following Icons: 
 

 
All 

Select All the objects on the screen. Hidden objects, fixed objects, backdrops 
and user guide objects are not selected. 

 
Unselect Unselect all the objects. 

 
Negate 
Selection 

Unselect the selection and select the unselected objects on the screen. Hidden 
objects, fixed objects, backdrops and user guide objects are not selected. 

 

Machine function 
Various machine functions are performed with the following commands: 
 

 
 

 Trim 
Apply the trim function to the selection. This means Thread will be trimmed 
before stitching this object. 

 Stop Stop the m/c before stitching this object. 

 
Needle 
Up 

Needle is up from previous object and to next object before stitching this 
object. 

 
Frame 
In/Out 

Toggle the frame In/out before stitching this object. 

 Borer Start Borer before stitching this object. 



 Appliqué Apply Appliqué function before stitching this object. 

 
Low/High 
Speed 

Toggle m/c to low speed. 

 

Object Size  
Object size toolbar shows the size of the Design or size of the selected objects. Once 
objects are selected one can change the size of the selected objects by altering the values 
and pressing <ENTER> key.  
 

 
 

X, Y Shows the offset values of the objects from center of the design. 

Size Next are the values of the object size in width and height. 

% Percentage values to be entered for change 

 Fix the values. 

 Cancel the values. 

 
 

 

Set color 
New objects created during digitization take the current color. A current color can be set 
by unselecting all objects and clicking on any color on the color toolbar. 
 

 
 
Select the object and press on color in color bar. Selection of any of these will change the 
color of the object for current selected fill type. 

 
Note: Doing single color design select all and then applying will make all the objects 
of the same color. 



Sequin Pallet commands 
In this section we will discuss the Sequin Pallet commands defined on the right hand side 
of Evx screen. 

 
Fuse Editing 

This function will start Evx in Fuse editing mode. This will help users to 
toggle sequins on the fly. See Fuse Editing for detail. 

 

Toggle 
Sequin In 
Area 

Any sequin under the selected Objects will be toggled (Sequin one will 
sequin two and sequin two will be sequin one) 

 

Remove 
Sequin In 
Area 

Any sequin under the selected Objects will be removed. 

 
Apply Sequin 
In Area 

Any stitch in the area under the selected will be applied a sequin. 

 
Adjust Sequin 
Count 

Adjust no of Sequins in the grammar with respect to length traversed. 

 

Remove 
Sequin Under 
Needle Point 

This tool helps us to remove all sequins under needle point in the entire 
design. This is helpful when we have a large design which is full of 
sequins. 
 

 
Apply Sequin 
two 

Apply Sequin two in the grammar for all selected objects. 

 
Shrink the 
Line 

This command will make the line exact multiple of stitch length defined in 
line parameters. This will shrink the line if not fitted in multiples. This is 
used for sequin lines. 

 
Set to Left 
Right 

This command will Set the starting point nearest to starting node of the 
object. 
If used with <CNTRL> key the operation will be reverse. 

 
Start Towards 
start Point 

This command will Set the starting node nearest to starting point of the 
object. 
 

 

Change 
Sequin 
Grammar 

See Change Sequin Grammar Command in detail. 

 Tight Stitch 

This command will see if any stitch is near to previous stitch of the same 
object, it will make this stitch exactly on the previous stitch. This helps us 
making all nearby stitch at the same point. Helps full for sequins designs 
where curves may deviate the stitches.  

 Sequin 
This tool helps us to put sequins in digitizing mode or in node editing 
mode on the node points. You can perform this command by pressing 
point sequin icon 

 Hide Sequin This tool helps us to hide/show sequins. You can perform this command 



by pressing point sequin icon. 

 
Show Stitch 
Position 

This tool helps us to put manual stitches over sequins in digitizing mode or 
in node editing mode on the node points. 

 
Transparent 
Sequin 

Toggle Transparent Sequin Mode. 

 

Convert 
Twine Sequin 
to Single 
Sequin 

This command will Convert Twine Sequin to Single Sequin 

 
Join 
Neighborhood 

This command will Join Neighborhood objects and make them a single 
object 

 
Remove Dst 
Style 

This command will remove the hanging style from the DST objects and 
create a object in which one can change properties of object 

 
Create Sequin 
Object 

This command will create a object in which one can change properties of 
object 

 
Join Objects 
Serially 

In Node editing this command will join objects to form a single object 

 

Join Dst 
Objects 
Gracefully 

This command will Join Dst Objects Gracefully. 

 
Update Dst 
Underlay 

It will increase the length of the run segment in Dst object. 

 
Create Dst To 
Objects 

This command will convert Dst Objects to punching objects. 

 
Attach 
Neighborhood 

This command will attach Neighborhood objects if they are very near to 
each other. 

 
Nearest Last 
Stitch 

Set start point to the nearest last point stitch. 

Fuse Editing 
This tool helps us to change sequins on the fly by clicking and then dragging the mouse 
on the screen. By default the mode is toggle sequin. On the fly area are generated with 
SHIFT, ALT and CRTL keys. SHIFT key used for boundaries. ALT key generates 
Circles and CRTL key generates the line segments. If toggle key is pressed again fusing 
modes comes to default mode. 
Other Modes are as follows: 

 
Toggle While in this command dragging on the screen will toggle sequins 

E 

 

Erase the 
sequin 

While in this command dragging on the screen will remove sequins 



S 

 

Insert 
Sequin 

While in this command dragging on the screen will put sequins on 
stitches 

1 

 
Sequin 1 Change sequins to sequins 1. 

2 

 
Sequins 2 Change sequins to sequins 2. 

SHIFT 
S 

 

Space 
Sequin 

This command will toggle the sequin 1 and space.   

Change Sequin Grammar 
This tool helps us to change sequins grammar of selected objects in one short. Sequin 
type drop down shows the type of sequin commands one want to change. Repeat is the 
occurrence of the command. Change to sequin type and repeat as above. 
 

 
 

View features 
These commands describe about showing/hiding various features of the design. 

 
Selection up 
to cursor  

This tool helps us to display stitches in play mode to clicked point. If this 
tool is unchecked then only you can select the objects in play mode. 

 Tabs Tool 
This tool used to see sequences(tabs) of objects on the screen. 
 

 
Find Next 
Function 

This tool helps us to find next function in design. This is in play mode. 

 
Hide Jump 
Points 

This tool helps us to hide jump point in the design 

 
Show Hide 
Connectors 

This tool helps us to show/hide connectors between various objects in the 
design. 



 
Hide Point 
Traces 

This tool helps us to show/hide the node points of punching of the objects 
in the design. 

 
Hide Start 
End Point 

This tool helps us to show/hide start/end points of the objects in the 
design. 

 Hide Traces 
This tool helps us to show/hide the traces of punching of the objects in the 
design. 

 
Actual View 
Stitches 

This tool helps us to toggle the actual view in 3D or plan view on whole 
screen. 

 3D View This tool helps us to toggle 3D View of the stitches on the screen. 

 
Toggle Hide 
Filling 

This tool helps us to toggle show/hide the stitches of the objects. 

 Show Outline This tool helps us to toggle show/hide the outline of the objects. 

 
Hide Needle 
Points 

This tool helps us to toggle show/hide the needle points of the stitches of 
the objects. 

 
Show Hidden 
Outlines 

This tool helps us to toggle show/hide Hidden Outlines of the objects. 

 Show stitches While in node editing use this tool to show or hide stitches. 

 
Show Last 
Stitch 

This tool helps us to toggle show/hide Show Last Stitch of the design. 

 

Start End 
Point Image 
Toggle 

This tool helps us to toggle Start End Point Image of the design. 
 

 
Measurement 
Tool 

This tool helps us to toggle Measurement Tool while punching. 
 

 
Machine 
Codes 

This tool helps us to toggle Machine Codes on the screen. 
 

 Display Borer
This tool helps us to toggle Display Borer on the screen. 
 

 Sound On/Off 
This tool helps us to Sound On/Off while punching. 
 

 
Find Short 
Objects 

This tool helps us to Find Short Objects in the design. 
 

 
Snap To 
Guides 

This tool helps us to Snap To Guides while punching. While punching if 
cursor is near to guides, it will be on the guilds. 
 

 

Unhide 
without 
selection 

This tool helps us to Unhide objects, without selection when using show 
by colors or unhide objects. 
 

 Show/Hide This tool helps us to toggle Show/Hide Drawing Objects on the screen. 



Drawing 
Objects 

 

 

Show/Hide 
Image 
Objects 

This tool helps us to toggle Show/Hide Image Objects on the screen. 
 

 

Pallet commands 
In this section we will discuss the miscellaneous commands defined on pallet on the right 
hand side of Evx. Commands are basically defined in three zones. First zone is basic 
commands and operate basically on objects and they are, in a way, directly related to 
stitch generation. The commands in second zone are related to stitch processing. And the 
last zone deals advance commands of Evx. 

Basic commands 
These commands are related to objects and are basic commands to perform on various 
objects. These operations basically help us to generate stitches. 

 Pallet Size 
Commands bar pallet is displayed on the right hand side. This can be 
displayed in one column or two columns. 

 Group 

Selected objects are formed as a group. They act like a single object. They 
are moved together. First of all, select all the objects you want to make as 

a Group. Now press ( ) or Ctrl G to make your selection a group. 
 

 Ungroup 

A group is ungrouped to individual objects. They act now as different 

objects. Select the grouped Object and press (  ). Grouped elements will 
be now individuals. 
 

 Unstitch 

You can use this tool to remove the stitches of the selected filled objects 

by pressing the unstitch Icon ( ). If you ungroup by pressing ungroup 

icon ( ) then outline will be available, and you can append right then. 
Alternatively you can also press <CTRL>+<SHIFT>+W to do this 
operation. This is required in case you want to append the selection or 
combine the selection (two or more lines can be joined just by pressing J). 
This can also be used in case you want to group different objects. 
 

 
Branches 
(Join) 

This is a very powerful command to join unlike stitches and seamlessly 
combine the stitches of unlike objects. This tool combines multiple filled 
objects and then resets their start and end points to minimize the stitches of 

the combination. Select filled objects and press branch icon ( ) to 
perform this operation. 



 

 

Break 
Branches 
(Join) 

This command is used to reverse branches (join) command. Select joined 

objects and press break branch icon ( ) to perform this operation. This 
will separate all the objects. 
 

 Attach objects 

Attach objects is a very powerful command to perform user defined 
routing of objects. This is activated when you are in play mode. During 
play mode you can divert the route of the stitches by selecting the object to 

be travelled next at stitching point and press attach object icon ( ). 
 

 
Shift and 
attach objects 

This command performs the same act as attach object and it also shifts the 
object to the current play location and leaves no gap. 

 
Attach 
Together 

This command performs the attach together all selected objects. 

 
Shift and 
attach objects 

This command performs shift and attach all selected objects. 

 

Adjust 
attachments 
to nearest 
point 

This command performs Adjust attachments to nearest point all selected 
objects. 

 Detach object 
This command will detach the selected objects from the attachments. You 

can perform this command by pressing shift and detach object icon ( ). 

 
Detach Object 
With List 

This command will detach the selected objects from the attachments as 
well as all objects attached to this object will also be detached. You can 

perform this command by pressing shift and detach object icon ( ). 

 Attach objects 
Attach objects is a very powerful command to perform routing of all 
selected objects. Braches will be attached at nearest first stitch. 
 

 
Attach objects 
end side 

Attach objects is a very powerful command to perform routing of all 
selected objects. Braches will be attached at nearest last stitch. 
 

 
Replace 
Objects 

This command will replace all the selected objects with the last one 
selected. If CNRTL key is pressed, then all the objects will also be rotated 
as well. 

 
Add 
Directions 

This command will allow user to add directions in the selected object. 

 Node Editing 

After you have digitized your designs, you may need to do some editing to 
it. Node editing tool is a tool to do so and can be invoked by pressing edit 

node point icon ( ) or pressing <N> will display the outline node. Select 
any object by clicking on it or by pressing <TAB> and then move the node 



points by dragging. 
 
Move the mouse near to the node point, mouse pointer will change the 
shape to a cross anchor. Clicking the mouse and dragging it will move the 
node to the new location. Also shape of the object is also changed. Once 
finished, press the right mouse button to fill the objects. 
 
 After finishing, you can press the same tool to come out of node editing. 
 
Note: Node editing is a single process and commands in node editing are 
combined for undo and redo. 
 

 
Select within 
polygon 

This tool helps you to do selection of objects falling in the digitized 
polygon. 

 Knife Tool 
This tool helps us to cut stitches in the DST file. All the stitch lines will be 
broken by the digitized boundaries. 
 

 Detach Fill This tool helps us to separate the stitches and out line. 

 
Detach 
Outline 

This tool helps us to separate the stitches and the outline is deleted. 

 
Process 
Stitches 

This tool helps us to increase or decrease the stitches in the DST file. 
Please see stitch process chapter for details. 

 
Process DST 
Width 

This tool helps us to increase or decrease the width of a DST design. 
Please see stitch process chapter for details. 
 

 
Remove 
Small Stitches 

This tool helps us to remove small stitches in the DST file or the punched 
design. Please see stitch process chapter for details. 
 

 
Remove 
Small Nodes 

This tool helps us to remove small nodes in the punched design. Please see 
stitch process chapter for details. 
 

 
Direction of 
Fill 

Set the direction of fill of the selected block ( ). Drag the mouse, the 
direction will be displayed on the screen. Right click to terminate the tool. 
Refilling the object, we will see the direction of fill is changed. 

 
Close/open 
Shape 

After drawing Bezier or polygon press ( ) to make it a close/open curve 
or polygon. 

 

Selection 
Within the 
Objects 

This tool helps you to do selection of objects falling in the selected ojects. 

 Crop Tool This tool helps one to do cropping of objects with selected objects. 

 Straight Tool This tool will rotate the selected objects Straight Horizontal or Vertical 



(With SHIFT Key). 

 Stitch Editor 

Select the filled object and press icon (  ). Now you can move the 
stitches. This is for a minor correction only. If you refill the object this 
info is lost. 
 

 Reverse Input Select an unfilled Bezier or polygon and select Reverse Input Icon ( ) to 
reverse input. This means starting point will be the end point of the Object.

 
Reverse 
Selection 

Select objects that you want to be positioned in the reverse order and press 

Reverse Selection Icon ( to reverse Selection. This means last object is 
now the first object in the punching sequence. 
If CNTRL Key pressed Objects will only be reversed in selection not in 
the design. 

 Select By This command helps us to do selection based on many inputs. 

 Bitmap Fill 
This command helps us to generate Tatami stitches of image in selected 
rectangle area over a backdrop image. 

   

 Pick Color 
This command helps us to change the color of the selected objects to 
match with the backdrop. 

 Pick Color 
This command helps us to change the color of the selected canvas objects 
to match with the backdrop. This will also create different canvas to match 
with 

 
Add Object to 
Canvas 

This command helps us to add cross stitched in the underneath canvas 
with the area of the selected objects. 

 Short Stitches Toggle Short Stitches of the objects. 

 
Smart 
Corners 

Toggle Smart Corners of the objects. 

 
Fractional 
Spacing 

Toggle Fractional Spacing of the objects. 

 
Polygon 
Operations 

 Union This will make union operation on selected polygon objects 

 Intersect This will make Intersect operation on selected polygon objects 

 Exclude This will make Exclude operation on selected polygon objects 

 Front – Back This will make Front – Back operation on selected polygon objects 

 Back - Front This will make Back - Front operation on selected polygon objects 

 Divide This will make Divide operation on selected polygon objects 



 Flatted This will make Flatted operation on selected polygon objects 

 
Combine 
Objects 

This will make Combine Objects operation on selected polygon objects. 
This means any overlapping in the object itself will be cleared. 

 
Merge 
Objects 

Merge Objects (CNTRL + T) will make a single boundary of the objects. 
If second object is central satin object, its both sides boundaries will be 
merged. 

 
Remove 
Overlapping 

This command helps user to remove overlapping boundaries of the 
objects. This is very useful when adding border and then remove 
overlapped areas. 

 Track Object This command helps user to track the object from dst objects. 

 Machine time 
This command helps user to now actual time taken by the machine to 
stitch the design. Various parameters required to get this time. 

 Limit color 
After reading a DST file if you limit the no of colors it will show the 
design as punched or it will be stitched. 

 
Collapse 
color 

This command helps user to bring all the objects with the same color near 
to each other. 

 
Convert To 
Cross Stitch 

This command helps user to Convert selected objects to Cross Stitch. If 
Selected object Area fill type is Patch, it will be added as a patch object in 
the cross stitch object. 

 
Shift To 
Boundaries 

This command helps user to Shift the boundary of first select object to 
boundary of second selected object. 

 Fit Eventually 
This command helps user to Fit Eventually the selected object. This means 
a ratio between first object and second object is calculated. Then this ratio 
is applied to the all objects on itself. 

 Add Anchor 
This command helps user to add Sequin 9 objects at all the node points so 
that a user can punch on its boundaries as these will be equal distance. 

 Bounds Sides 

This command helps user to Bounds Sides of stitches. Area fill types 
objects as crop fill type used to bound stitches. Crop fill type with reverse 
will reverse the stitches on boundaries. 
See Examples Bellow. 

 
Head 
selection 

This command helps user to do Head Selection of objects. 
See Examples Bellow. 

 
Laser Head 
selection 

This command helps user to do Laser Head Selection of objects. 
See Examples Bellow. 

 Envelope 

This command helps user to do Envelope of Selection of objects. 
Envelope is formed around all the selected objects. In Node editing one 
can change the objects as well as the shape of the envelope. 
See Examples Bellow. 

 
Read DST as 
clubbed 

This command helps user to Read DST as clubbed objects of the same 
color. This will not divide the objects in small sizes. 



 
Set Next 
color 

This command helps user to Set Next color of the all selected objects. 

 Add Bend 
All the hard (Corner) nodes of the selected objects will be converted to 
three points to form a round band. 

 
Merge 
Canvas 

All selected canvas (Cross stitch) objects will be merged to fom a bigger 
canvas. 

 Stretch Points
This command helps user to Stretch Node Points of all selected objects, to 
become Perpendicular lines. 

 
Proportional 
Stitch Length 

This command helps user to make Proportional Stitch Length of all 
selected objects as reference to first object. 

 
Place me 
Gracefully 

This command helps user to make Place me Gracefully of second selected 
object on first selected objects. 

 
Place me 
Gracefully 

This command helps user to make Place me Gracefully of second selected 
object on first selected objects. 

 
Fit To 
Quadrant 

This command helps user to make Fit To Quadrant First selected object 
rest of all selected Quadrant objects. If any of the rest of the objects is two 
nodes points first objects will be flatted on this object. 

 Crop and fit 
This command helps user to make Crop and fit selected object rest of all 
selected Quadrant objects. 

 
Add Spaced 
lines 

This command helps user to make Add Spaced lines in all selected object. 
Line will be with alternative color, which will help us to fill different 
stitch types at a later stage. 

 
Expend the 
line 

This command helps user to Expend all selected line object. Offset can be 
changed at Add Border Dialog box. 

 
Connect 
Objects 

This command helps user to Connect two selected Objects with central 
satin line object. 

 
Close on 
Close Objects

This command helps user to close the object by adding boundary nodes of 
the closed object. 



 

 
 
 
 
 
 
 
 
 
Bounds 
Sides 

 
 
 
 
 
 
 
 
 
Bounds 
Sides 

 
 
 
 
 
 
 
 
 
Envelope 
Objects 

 



 

Head Selection 

 
 

 

Status bar 
We can see the status of various actions on the status bar. This includes dimensions of the 
object, stitches of the object, current mouse position and many more. 
 

 
 
Status bar shows stitches information in play mode as follows: 
 

 
 

S: Current stitch count 
DX: Distance in x of current stitch 
DY: Distance in y of current stitch 
L: Length of current stitch 
X: Current X position of the stitch 
Y: Current Y position of the stitch 
dx: Mouse distance in x from last clicked position 
dy: Mouse distance in y from last clicked position 
d: Mouse distance from last clicked position 
X: Current Mouse x position 



y: Current Mouse y position 
L: Left position of selected objects 
T: Top position of selected objects 
W: Width of selected objects 
H: Height of selected objects 
N: Number of stitches of selected objects 
Q: Number of sequins of selected objects 
G/J: Selection is group or Joined object. 
NNN: Current zoomed factor  
Time Current time of the system 

Miscellaneous commands 
These are the commands which help punchers to perform miscellaneous operations. 

Design size 
Design size appears on the status toolbar when no objects are selected. Press A to do any 
kind of transformation on the design. 

Shift Together 
Selected Objects can be brought together by pressing shortcut key CNTRL + T. 

Shift (Right to Left) or (Bottom to Top) 
Selected Objects can be brought together from right to left or bottom to top by pressing 
shortcut key CNTRL + SHIFT+ T. Right or top is based on height or width of the object. 
 



Digitizing/punching 
In this section we will discuss how to digitize (punching) a new design. 

Shortcut key for punching 
Punching is made easy with shortcut keys. Following table show various shortcut keys. 

Key Description 
F2 SATIN 

F3 TATAMI 
F4 ZIGZAG 
F5 E-FILL 
F6 LINE 
F7 PROGRAM FILL 
F8 SATIN CENTRAL 
F9 ALPHABET 

F10 PIPING 
F11 CROSS STITCH 
F12 MOTIF 

 
Press shortcut key according to yours requirement, and click left mouse button on the 
screen to create outline. Release the mouse and move to another location and again click 
the next location and so on. You can stop punching for the current object by pressing 
right mouse button. Now if you again click left mouse button a second object will be 
started for punching. If you want to stop punching again press right mouse button, evx 
will ask for end point of the current objects. Click the point on the screen to specify the 
end point. If you don’t want to specify any end point just right click again. All the objects 
will be joined together to form a joined group. You can break them apart by pressing 
<CTRL> + B. You can reshape the objects now by pressing N and when done, press N 
again to come out of it. 
 

   

Bezier/spline dual tool 

Bezier/spline/Dual Sides (  ,  ,  ) dual tool generates Bezier curves going 
together. At each node point there is a direction with the other line and there are two 
handles. A handle is used for shaping the curve. Dragging the handles will move the 
curve along the handle in a stretched way. 



Append tool 

Append tool ( ) is used for appending the previous punched outlines. You might have 
stopped digitizing or you may be inclined to append the already created outline. 

Curve and line 
You can toggle the node between a curve and a line by pressing shift and clicking on the 
node point. 

Circle and line 
You can toggle the node between a line or a curve to circle by pressing Alt + X and leave 
it and then pressing shift and click on the node point. As three points are required to draw 
a circle, we need to click on the center node. 

Delete node while digitizing/punching 
When drawing Bezier or a polygon and at any point of time a node is wrongly punched, 
press backspace to delete the previous node. Another method is press the shift key and 
drags the wrong point punched to the desired location.  

Delete node 
Select the object and then click on the node point of the object you want to delete and 
press backspace. The current node point will be deleted. If there are directions associated 
with this node point, they will also be deleted. 

Insert node, directions 
Select the object and press Alt and click on the outline/boundary where you want to insert 
a node point. Press CTRL key and click on one of the outlines, a direction will be added 
at the outline with a node. 

Add/delete directions 
Please see Insert/Delete Node command. 



Filling parameters 
There are different parameters for each type of fill. The user can change any fill 
parameters at any time.  All stitching parameters are taken from the current parameters. 
Current parameters are set when no object is selected and you are setting the parameters. 
Selecting an object and right clicking on the stitch type icon will open the dialog box for 
setting the parameters for that object. 

General parameters 
General parameters are shown in the following dialog box: 
 

 
 



Pull compensation value 
This is the value (in mm) by which you want to overstitch the stitches. 

Pull compensation sides 
This indicates the pull compensation to be applied to sides. (Side 1, Side 2, Or both). 

Start Offset 
This is the value (in mm) by which you want to overstitch the stitches at start of the 
object. 

End Offset 
This is the value (in mm) by which you want to overstitch the stitches at end of the 
object. 

Fix/lock stitch  

Any object created or filled is automatically locked. Lock icon  is shown as pressed if 
objects selected are locked. By pressing Lock icon again locked objects are unlocked and 
unlocked are locked. Stitch locks are of two types: Lock the first stitch and lock the last 
stitch. These values can be set individually in object properties as shown in the following 
figure. 

 

 
 

Choose the value from the dropdown menu for this parameter. 
The choices that you have for this field are: 

None No locking 

First Apply stitch lock at the beginning of stitching this object 

Last Apply stitch lock at the ending of stitching this object 

Both 
Apply stitch lock at the beginning as well as the ending of 
stitching this object 

No of Stitches 
This is the no of stitches to be applied in locking. Default value is 4. 

Lock Stitch Length 
This is the value (in mm) by which one want to use for stitch length of the locked 
stitches. 

First Lock Perpendicular 



If this parameter is checked then First lock will be applied as Perpendicular to the first 
stitch. 

Last Lock Perpendicular 

If this parameter is checked then Last lock will be applied as Perpendicular to the last 
stitch. 

Last Types 
The choices that you have for this field are: 

Linear Linear stitch will go over to the stitching. 

Star Star stitch will go over to the stitching. 

Rectangle Rectangle stitch will go over to the stitching. 

User 
defined 
Lock (UDL) 

User defined Lock (UDL) Style in the styles list will go over to 
the stitching. 

Over run 
lock 

Over run lock used for laser machines and is applied to closed 
objects. This will stitch extra one stitch in the closed loop. 

 

Area angle of fill 
This is the direction of fill for Tatami fill. Choose the value for this parameter. 

Segment run length 

This parameter specifies the stitch length of the tracking segments. 

Minimum Stitch length  

This parameter specifies the minimum stitch length of the tracking segments. Any 
segment with less than this length will be counted as a short stitch. 

Cord Gap 

Cord gap is used to tighten the line segments to the digitized outlines. This is the 
maximum distance to be allowed between the outline and the stitches. When this value is 
exceeded the stitch length is reduced to follow the outline more closely. 



 

Centre Single Tracking 

If this parameter is checked then single tracking will be in the center of the stitches. 

Centre Double Tracking 

If this parameter is checked then double tracking will be in the center of the stitches. 

Ignore First stitch in branching 

If this parameter is checked then first stitch of this object will be ignored in branches. 

Ignore Last stitch in branching 

If this parameter is checked then last stitch of this object will be ignored in branches. 

Smart corner 

If this parameter is checked then smart corner will be considered in satin for this object. 

Stitch shortening 
Stitch shortening parameters are shown in the following dialog box: 



  

Spacing threshold 
Spacing Threshold specifies the maximum spacing allowed as a percentage of the normal 
stitch spacing. If the spacing between the alternative stitches is less than this value, 
stitches will be shortened. 

Max no of short stitches 
Max no of short stitches is the limit for consecutive shortened stitches. You can specify a 
maximum of five for this parameter. 



Randomize 
Check this value to randomize the shortened stitches. This will reduce unwanted lines 
appearing on a regular curve. 

Jagged edge 
Jagged Edge parameters are shown in the following dialog box: 
 

 
 

Jagged side 
Choose the value from the dropdown for a jagged side i.e. both sides, side1 or side2. 
The choices that you have for jagged are: 



 

Jagged on both sides. 

Jagged only on the first side. 

Jagged only on the second side. 

 

Range 
Choose the value from the dropdown for the jagged range. In the Range field, enter the 
margin in which you want the stitches to fall. 

Roughness  
In the Roughness field, enter a value between 1 and 10 to indicate the required degree of 
jaggedness. Larger the value, the more variation in the stitch length. 

Auto jump parameters 
Auto Jump parameters are shown in the following dialog box: 



 

Auto jump check box 
Check this box in case you want to go for auto jump for this object. Long stitches will be 
automatically broken in to small jump stitches as per parameters. 

Maximum stitch length 

This is the length beyond which a stitch will be broken into small jumps stitches. 

Jump stitch length 
This is the length to which jump stitches will be generated. 



Length Calculation 
Length can be calculated as diagonally or maximum of horizontally and vertically. 

Auto split check box 
Check this box in case you want to go for auto split for this object. Long stitches will be 
automatically broken in to small stitches as per parameters. 

Design parameters 
Design parameters are shown in the following dialog box: 

 



Sequin locking angle 
This is the angle at which a locking line will be inclined to the current stitch while in 
playing mode and applying L (lock) command. 

Underlay properties 
This parameter is applied on underlay stitches only. 

Piping angle This is the angle at which piping underlay will be 
inclined to the current fill.  

Netting Angle This is the angle at which netting underlay will be 
inclined to the current fill. 

Stitch space Piping This is the stitch spacing in piping underlay. 
Stitch space netting This is the stitch spacing in netting underlay. 
Tracking From 
Border 

This is the distance from the boundary at which tracking 
will be generated 

Wide /Narrow 
Distance 

This is the distance between the boundary at which Wide 
or Narrow tracking will be distinguished. 

Narrow Distance 
from border 

This is the distance between the boundary at which 
Narrow tracking will be generated. 

Wide Distance from 
border 

This is the distance between the boundary at which Wide 
tracking will be generated. 

  

Use Head Selection 
Check this value to use head selection in the m/c format files. 

Create color change file 
If checked, an XML file will be created for color change. This file may be required by 
some embroidery machines. 

Convert Twine Sequin To AB 
Check this value to Convert Twine sequin to AB format in dst file. 

Don’t Lift Sequin Device On Jumps 
Check this value to Disallow m/c to list the sequin device at jump points. This feature is 
used for lesser m/c in DST file formats. 

Use Lesser for Borer function 
Check this value to generated output file for lesser beams embroidery mc/ in DST file 
formats. 

Accordion parameters 
Accordion parameters are shown in the following dialog box: 



 

Accordion 
Check this value to use Accordion on the object. 

Max Stitch space 
Max Stitch space is the maximum space between the stitches of the object. 

Accordion Type 
Accordion Type; show how you want the spacing to be created in the object. 

Smart Corner parameters 
Smart corner parameters are shown in the following dialog box: 



 
 

 

Smart Corner 
Check this value to use smart corner on the object. 

Cap corner  
Check this value to use smart corner on the object. 

Mitre corner  
Check this value to use mitre corner on the object. 



Cap bellow angle  
Cap bellow angle is angle bellow which cap corners will be applied on the object. 

Mitre bellow angle  
Mitre bellow angle is angle bellow which mitre corners will be applied on the object. 

 

Sequin parameters 
Sequin parameters are shown in the following dialog box: 
 

 
 

Sequin 
Check this value to apply Sequin on the object. 



Lift Sequin Device 
Check this value to lift Sequin device after completing the object. 

Sequin Pallet 
Sequin Pallets are used for type of sequin one wants to apply on the object. 
One can change the pallets by clicking on the dropdown arrow, and selecting the one of 
your choice. 

Edit Pallet 
Sequins properties can be changes by clicking on to “Edit Pallet” button. Following 
dialog box will be opened. 

 

Diameter 
This is the diameter of the sequin in the current pallet. 

Beads Height 
Bead can also be used instead of sequins. This is the Height of the bead, if are used in 
current pallet. 

Sequin Shape 

Sequin comes with various shapes. You can select any shape here to show the sequin on 
the screen. If your sequin in not in the list you can define a shape of the sequin, by 
creating a style with the name as “udss1” User defined sequin shape 1, or  “udss2” User 
defined sequin shape 2. And select here. You can also see the in examples. 

Sequin Hole Position 
This is the position where hole is on the sequin. 



Sequin Color 
This is the color of the sequin to be used for display. You can select the color by set color 
commands. 

Add New Sequin Pallet 
This can be used to create a new pallet if we wish. 

Make All Sequin Alike 
This is used to copy to colors of sequin pallets to make them for toggle effect. 
 

Lock Type 
You can lock the sequins by additional stitches. These are the locks used for locking the 
sequins. 

Offset 
Offset is the distance away from the sequin to apply locks. 

Sequin Lock 
Sequin Lock if checked, locks will be applied, defined in the name parameter of the 
object. 

Sequin On 
This option helps you to apply sequin on first stitch, last stitch or all stitches or in 
between stitches in satin. 

Skip Sequin 
Skip on First Stitch, Skip On Last Stitch, Skip Last Sequin, or skip sequins in running 
with count. 

Force North Drop 
This option applied will force the stitch generation for sequins in such a way that sequins 
will be dropped only from North (Top), in the same way Force South Drop. Force Style 
Frame 123 will apply frame 1 of the style for sequin 1 and frame 2of the style for sequin 
2 and frame 3 of the style for AB or 1+2 or 2+1 Sequins. Force Route crafting will add 
extra underlay and then apply sequins in smart way. 

Force Extra Gap Stitch 
This option when on will generate extra Gap Stitch to bring the sequin appearance 
symmetrically. 

Force Extra Gap Stitch Reverse 
This option when on will generate extra Gap Stitch when generating stitches from end 
node of the object, to bring the sequin appearance symmetrically. 



Force Long Stitch 
This option when on will generate long stitch to bring the sequin appearance 
symmetrically. 

Stitch Length 
This is the stitch length for sequin 2. You must add a style in line fill parameter to apply 
sequin 2. 

Stitch Gap 
This is the stitch gap used for sequin 2. 

Mild Gap Stitch 
This is the stitch length for mild Gap used for sequin. 

Sequin Pallet Index 
This is starting index of the pallet to be used for applying sequin. 

Sequin Grammar 
We define the way to apply sequins in the object. We can define multiple rows in the 
grammar. Sequins generations will be from left to right till end of row is reached. Then 
second row will be parsed and so on, till you reaches last row. After parsing last row first 
row will be parsed and continue.  

Move Up 
This command will bring the selected row to upper side. 

Move Down 
This command will bring the selected row to bottom side. 

Insert Row 
This command will add a new row at current position. 

Delete Row 
This command will delete row at current position. 

Insert Column 
This command will add a new column at current position. 

Delete Column 
This command will delete current column. 

Reverse 
This command will reverse the grammar. 



Satin 
Satin parameters are shown in the following dialog box: 

 
 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 



Number of run 
This parameter specifies the number of times a line should be repeated in the satin stitch.  

Style 
This parameter specifies the style from the drop down. You can add new styles to the 
system with style editor. 

Sweep to Fit 
This parameter specifies the Stitches must be fit in the stitch space between a pair of 
lines. This is used to form coiling effect. 

Fit to Boundary  
This parameter specifies the stitches must fit along the boundary. 

Use coiling Stitch 
This parameter specifies that a coiling stitch must be formed. 

Frame First From 
This parameter specifies the Frame no of the style to be used at starting. 

Frame First To 
This parameter specifies the Last Frame no of the style to be used. 

Frame Second From 
This parameter specifies the Frame no of the style to be used at returning line. 

Frame Second To 
This parameter specifies the Last Frame no of the style to be used at returning line. 

Style on 
This parameter specifies the style on from the drop down. Style on options are as follows: 
 

First stitch 
Style will start on alternative stitches starting from 
first stitch. This means second, fourth stitches will be 
normal. 

Both stitches 
Style will start on both stitches starting from first 
stitch. 

First Stitch With Stretch 
Style will start on alternative stitches starting from 
first stitch. This means second, forth stitches will be 
normal. But during scaling the style is not retained. 

Both Stitch With Stretch 
Style will start on both stitches starting from first 
stitch. But during scaling the style is not retained. 



Threshold Width 
This parameter specifies that if boundaries gap increased more than this value then 
change the Style Frame No to next available Style frame. 

Threshold Offset 
This parameter specifies that if boundaries gap increased more than this Threshold Offset 
values then for each offset value found change the Style Frame No to next available Style 
frame. 

Stitch length 
This parameter specifies the Stitch length used while using style. 

Style Height 
This parameter specifies the Style Height to be used while using style. 

Square end  
This parameter specifies that while returning, a second stitch will be generated from 
opposite side. 

Return to Same Point 
This parameter specifies that while returning, a second line stitch will be generated on the 
first line. 

Crop to Boundary 
This parameter specifies that after stitch generation stitches must e cropped to boundary. 

Random Style 
This parameter specifies that for each line stitches must be randomized. 

Repeat Count 
This parameter specifies that if style is not there generate one using this repeat count. 

Repeat Offset 
This parameter specifies that if style is not there generate one using this repeat offset. 

Repeat Offset 2 
This parameter specifies that style generate should be reduces by this value for each line. 

Overlapping percentage  
This parameter specifies that if style should use this value to overlap. 

Line Parameter 
Some of the parameters of the line can be changed here for line fill. 



Pattern Fit 
This parameter specifies the pattern fit type from the drop down to be applied for satin 
stitches. 
 

None: Actual length with which pattern was created will be 
used to repeat patterns on the Satin. 

Ceeding: Depending on the pattern length, number of patterns will 
be placed in the Satin stitch. 

Fit 1-10: This parameter specifies how many times a pattern will 
be repeated in Satin. 

 
 
Pattern length: This is the length of the pattern to be used if you have selected the 
ceeding option for the pattern fit parameter. 

Pattern name 
This parameter specifies the pattern name from the drop down to be applied for satin 
stitches. You can add a new pattern to the system with pattern editor. Patterns are needle 
penetration points to reflect the shapes. 

Inclined Fill 
This parameter specifies that generate inclined stitches. 

Spikes Fill 
This parameter specifies that generate spikes stitches. 

X Stitches 
This parameter specifies that generate X(Crossed) stitches. 

Zigzag Stitches 
This parameter specifies that generate Zizag stitches. 

Auto split check box 
Check this box in case you want to go for auto split of the long stitches for this object. 
Long stitches will be automatically broken into small stitches as per the parameters. 

Auto split Alternative 
Check this box in case you want to split alternative lines. 

Length 

This is the length beyond which a stitch will be broken into small stitches. 

Minimum length 
This is the minimum length to which stitches will be generated. 



Tatami 
Tatami parameters are shown in the following dialog box: 

 

 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 
 

 
 



Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Minimum stitch length 
This parameter specifies the minimum distance between a pair of stitches. Any stitch less 
than this value will be ignored. 

Offset fractions 
This parameter specifies the distance between a pair of stitches on different lines. By 
manipulating offset fractions, you can create fills where obvious split lines are not visible 
and the stitch penetrations are more clearly visible. 

Offset sequin 
This parameter specifies that sequins should be placed at the offset position. 

Backstitch 
There are two types in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

 



Zigzag 
Zigzag parameters are shown in the following dialog box: 
 

 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stars Fill 
Stars fill parameters are shown in the following dialog box: 



 

Star Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Star offset 
This parameter specifies the number of edges to omit between two edges of the star to be 
formed on the outline boundary of the circle. If this parameter is zero than a perfect star 
will be created. Increase this parameter to create a big hole inside the circle so that we 
can use this to fix a mirror inside. 



 
 
This parameter also defines the no of line to be generated for plasma fill. If zero then all 
the lines will be generated till object if completely filled. 

Create pagdhi stitch 
This parameter specifies that stitches created in plasma to be adjusted to have a pagdhi 
stitch look. 

No extra pagdhi stitch 
This parameter specifies that extra stitches created at start and at end should be removed. 

Back from center 
This parameter specifies that back from center while creating stitches using plasma fill. 

Advance one offset 
This parameter specifies that offset defined should be used and one to be added to it. This 
will create a cycle rim type stitch effects. 

Back on same line 
This parameter specifies that back on the same line from where it entered in to next line 
while creating stitches using plasma fill. 

Back on same line with half gap 
This parameter specifies that back on the same line from where it entered in to next line 
while creating stitches using plasma fill, using half the gap stitch. 

User defined center point 
This parameter specifies that center point of the object should be taken as defined by the 
user. 

Add sequin in the center 
This parameter specifies that apply a sequin in the center of the object before generating 
stitches. 

Lock on sequin 
This parameter specifies that apply a lock on sequin generated in the center of the object 
before generating stitches. 



No sequin on border 
This parameter specifies that no sequin should be generated on the border of the object. 

Plasma Fill 
This parameter specifies that use plasma fill on the object. 

Plasma with line Fill 
This parameter specifies that use plasma fill on the object, using line fill parameter. 

Parameter 
This parameter used to change parameters (line fill) used plasma fill on the object. 

Auto reverse fill 
This parameter specifies that use reverse the stitches generated on the object. 

Alternative reverse 
This parameter specifies that use reverse alternative lines of the stitches generated on the 
object. 

Auto fix start to end 
This parameter specifies that fix the start and end points of the stitches generated on the 
object. 

User defined center point underlay 
This parameter specifies that create underlay of stitches at each hard node starting from 
the center of the object. 

Dorri specific tracking 
This parameter specifies that tracking should be straight of stitches from lines to line. 

Add to middle 
This parameter specifies that add straight line stitches in the middle if the object. 

Back with offset 

This parameter specifies that back stitches should be with offset. 

Triangle stitch 
This parameter specifies that a triangle stitches should be created when stitches are less 
than 30 degrees apart. 

Jalebi turn stitch 

This parameter specifies that create stitches like a spiral. 



Contour type 
There are two types in which a contour can take place. One is offset corners and the other 
one is spirals as specified in the dialog box. 

Backstitch 
There are two types in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

E-fill 
E-fill parameters are shown in the following dialog box: 

 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 



Stitch length 
This parameter specifies the Stitch length used to create stitches. 

Stitch length backward 
This parameter specifies the Stitch length used to create stitches while returning. 

Number of runs 
This parameter specifies the number of times stitches will be repeated. 

Offset sequin 
This parameter specifies that first sequin should be offset. 

Reverse sequin 
This parameter specifies that sequins should be placed on backward stitches. This is 
applicable when sequins are applied on the objects. 

 

Omit last stitch 
Omit the last stitch of each line generated. This helps in sequins designs. 

Same back track 
This parameter specifies that when creating a back track, it must go over the stitches 
only. 

User offset point 
This parameter specifies that E stitch to be created emerging from the user defined point. 

Force last frame on last stitch 
This parameter specifies that last stitch to have last frame of the style. 

One way stitching 

This parameter specifies that in single object using E-fill to create stitches in one 
direction only. 



First gap stitch 
This parameter is used to specify that first create a gap stitch with half the length of stitch 
length and then creating remaining stitches. This helps us to apply sequins with single 
motif. 

First gap stitch as stitch 
This parameter is used to specify that first gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps one to get adjust stitch lengths for 
sequin. 

Start and end at first stitch 
This parameter is used to specify that first and last stitches created must be start and end 
at first stitch of the object. This helps one to apply locks in sequin designs . 

Style 
This parameter specifies the style from the drop down. You can add new styles to the 
system with style editor. 

Frame From 
This parameter specifies the Frame no of the style to be used at starting. 

Frame To 
This parameter specifies the Last Frame no of the style to be used. 

Line parameter 
If one want to apply auto generated style using repeat count, one can set it using line 
parameter. 

Towel embroidery 
E-Fill stitch is used for towel embroidery. Create an object with a single outline. Under 
PM parameters specify fill angle to be 90 degree. Use e-fill on the object with stitch 
length as 4mm and stitch length backward as 0.4 mm. A towel device must be installed 
on the embroidery m/c. 
 

  
Normal E Stitch                                              Towel Embroidery stitch 



Line 
Line parameters are shown in the following dialog box: 
 

 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 



Stitch gap 
This parameter specifies the distance between a next pair of stitches after a stitch. 

Random factor 
This parameter specifies the randomization between various stitches. This will force the 
stitches to be generated uneven. 

Number of runs 
This parameter specifies the number of times stitches will be repeated. 

Style Height 
This parameter specifies the height of the style to e applied. If this parameter is 0 then 
style height is proportional calculated from the stitch length. 

Repeat Count 
This parameter is used to generate multiple run of the stitch. 

Repeat Offset 
This parameter is used to specify the offset between to stitches in the repeated style. 

Repeat Skeq 
This parameter is used to specify the inward length of stitches in the repeated style. 

Upside only 
This parameter specifies that stitches to be generated upside only. 

No Overlapping 
This parameter specifies that stitches to be generated Without overlapping each other.  

Start repeats at first stitch 
This parameter is used to specify that while creating a style from repeat count first stitch 
of the style must laying on the current stitch of the object. 

Style 

This parameter specifies the style from the drop down. You can add new styles to the 
system with style editor. 

Frame from 
This parameter specifies the starting frame of the style. All the frames will be applied 
until frame end (if specified) is reached or there are no more frames left. 

Frame to 
This parameter specifies the ending frame of the style. All the frames will be applied until 
frame end (if specified) is reached. 



 

Reverse Style 
This parameter specifies that reverse the stitches of the style before applying. 

Use manual fill 
This parameter specifies that stitches should be generated is if we have punched them out 
on the screen. This is used when users want to use stitch creation according to their own 
will. 

Equal line segment 
This parameter specifies that stitches should be generated with equal line segments. If 
this parameter is unchecked than cord gap factor will be used to create stitches nearest to 
the outline. 

Style on line 
This parameter specifies that a line stitch should be created from the starting point till the 
other side and back track stitched should be created from the style used and it should 
follow till the end point. 

Line on style 
This parameter specifies that stitches should be created from the starting point of the line 
and a back track should follow from the last stitch and all the stitches in backtrack should 
be reverse of all the stitches generated while going forward. 

User style 
This parameter is used only when sequins are applied on the object. This parameter 
specifies that stitches should be created from the starting point of the line till all manual 
sequins are applied and then again apply this stitch pattern to the rest of the line. 
 



 

Use motif stitch length 
This parameter is used to specify that use motif stitch length instead of stitch length. 

Motif stitch length 
This is parameter specifying the motif stitch length. 

Use tracking length 
This parameter is used to specify that use tracking stitch length instead of stitch length, as 
and when a tracking is added. 

Back track mirror 
This parameter is used to specify that add a back tracking in the style from the style 
mirror. 

Back track mirror style fill style 
This parameter is used to specify that add a back tracking in the style from the style 
mirror, and add fill the object defined in Style fill type dropdown. 

Track on style 

This parameter is used to specify that tracking to e added on points defined in the style. 

Skip motif first stitch 
This parameter is used to specify that if motif is used than skip first stitch of the motif. 

Skip motif last stitch 
This parameter is used to specify that if motif is used than skip last stitch of the motif. 

Omit first stitch 
This parameter is used to specify that omit first stitch of the object. 



Omit last stitch 
This parameter is used to specify that omit last stitch of the object. 

Omit first motif 
This parameter is used to specify that omit first motif of the object. 

Omit last motif 
This parameter is used to specify that omit last motif of the object. 

No gap stitch at end 
This parameter is used to specify that if gap stitch comes at end of the object, it must e 
omitted and must be adjusted with previous stitches. 

Use bare raw style 
This parameter is used to specify that style should not be rotated along the line of the 
object. It must be as it is as defined. 

Adjust stitches on curve 
This parameter is used to specify that if last stitch is not covered properly is must adjust 
stitches on curve of the object to fill properly. 

Back track mirror next frame 
This parameter is used to specify that if using back track mirror then next frame of the 
style should be used in back tracking. 

Change frame at nodes 
This parameter is used to specify that while generating the stitches, at every node of the 
object next frame of the style should be used. 

Named stitches length percentage  
This parameter specifies parameters defined in name of the objects in numbers to be used 
as length percentages. This helps you to get multiple stitch lengths in the same object. 

Force last frame of last stitch 
This parameter is used to specify that apply last frame of last stitch of the object. 

Use gap stitch as stitch 
This parameter is used to specify that all the gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps you to get two stitch lengths in the 
same object. 

Half back track 
This parameter is used to specify that while creating a back tracking, back stitches must 
be half the going stitches. This helps one to bind the sequins with back tracking. 



Alter motif height 
This parameter is used to specify that motif height must also be adjusted as stitch length 
varies. 

Mirror alternative motif 
This parameter is used to specify that while applying motif mirror alternative motif. 

First gap stitch 
This parameter is used to specify that first create a gap stitch with half the length of stitch 
length and then creating remaining stitches. This helps us to apply sequins with single 
motif. 

First gap stitch as stitch 
This parameter is used to specify that first gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps one to get adjust stitch lengths for 
sequin. 

Start and end at first stitch 
This parameter is used to specify that first and last stitches created must be start and end 
at first stitch of the object. This helps one to apply locks in sequin designs . 

Half last stitch 
This parameter is used to specify that last stitch should be halved. 

Motif 
This parameter specifies the motif from the drop down. You can add new styles to the 
system with style editor. This is the motif which will be applied on the stitches generated. 
This helps one to apply additional style for creating beautiful designs. 

Swap Style 
This parameter is used to specify that swap the style with motif. 

Motif angle 
This parameter specifies that the motif (Style) should be rotated by this angle before it is 
applied to stitches. Following figures show style with 0 degree rotation and style with 90 
degree rotation. 



 

Motif Stitch length 
This parameter specifies the stitch length of motif to be applied. 

Motif gradient 
This parameter specifies the stitch length of motif to be gradually percentage of this 
factor. 

Gradient threshold 
This parameter specifies the stitch length of motif to be fixed after this value is reached. 

Spiral offset 
This parameter specifies the offset from the center of the spiral to be generated. Spiral 
stitches will be generated after this distance from the center. 

Limit spiral turns 
This parameter specifies that spiral created should limit the no of turn defined in spiral 
properties of the object. 

Equal motif segments 
This parameter specifies that motif applied on the stitches must also be of equal stitch 
length. 

Use manual 
This parameter specifies that motif applied on the stitches must use manual stitches 
created by style. 

Cap spiral 
This parameter specifies that spirals must be bounded by line stitch length. 

Style fill type 

This parameter specifies that style must be filled by style fill type. 

Parameter 
This parameter specifies that style fill type parameter. 



Central satin 
Central satin parameters are shown in the following dialog box: 
 

 

Column width 
This parameter specifies the column width of the central satin. 

Offset 
This parameter specifies the offset distance of central satin for symmetrical objects. 

Create satin outline 
This parameter specifies that create satin outline of the selected objects. 

Delete original 
If create satin outline is checked and this option is also checked then delete the original 
objects after creating their satin outline. 



 

Directions in central fill 
You can add directions in objects created by central objects. 

 

Balloon in Central 

We can create balloon in central satin. Create a object over the central and declare it as 
balloons in object properties. Select first central object and then balloon object, and press 
control W. flowing picture show the results. 



 



Alpha 
Alpha parameters are shown in the following dialog box: 

 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Height 
This parameter specifies the height of the alphabets. 

Width 

This parameter specifies the width of the alphabets.  Zero or 100 means width is taken 
from the fonts itself. 

Escapement 
This parameter specifies the Escapement of the alphabets.  This value is measured in 
degrees of angle. Stitched alphabets will be tilted at their base by this angle. 

Split alphabets 
This parameter specifies that alphabets are available for editing and are not internally 
joined. 



Outline alphabets 
This parameter specifies that alphabets outline is created and filled with the line fill. 

Outline drawing 
This parameter specifies that alphabets outline is created as drawing objects without fill. 

Italic angle 
This parameter specifies that alphabets to use this angle as italic. 

Input type 
This parameter specifies the way the user wants to create the outline. 
 

Straight 
line 

Two point on horizontal axis 
 
 
 
 
 
 
 
 
 

Two 
point line 

To points slanting angle 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Three 
point arc 

Three point forming an arc 
Input Method: 
 
 
 
 
 
 



 
 
 
 
Output stitches: 

 
 

 

Program 
Patterns are needle penetration points to reflect the shapes. Program fill is the one of the 
methods to do so. Program parameters are shown in the following dialog box: 
 



 

Pattern name 
This parameter specifies the pattern name from the drop down to be applied for program 
stitches. You can add new patterns to the system with pattern editor. 

Size X 
This parameter specifies the size X (width) of the pattern. 

Size Y 
This parameter specifies the size Y (height) of the pattern. 



Column spacing 
This parameter specifies the column spacing of the pattern. The number of times pattern 
appears horizontally is calculated from this value. 

Column offset 
This parameter specifies the column offset of the pattern. This is the distance between 
two columns for patterns to appear. 

Row spacing 
This parameter specifies the row spacing of the pattern. The number of times pattern 
appears vertically is calculated from this value. 

Row offset 
This parameter specifies the row offset of the pattern. This is the distance between two 
rows for patterns to appear. 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Minimum stitch length 
This parameter specifies the minimum distance between a pair of stitches. Any stitch less 
than this value will be ignored. 

Offset fractions 
This parameter specifies the distance between a pair of stitches on different lines. By 
manipulating offset fractions, you can create fills where obvious split lines are not visible 
and the stitch penetrations are more clearly visible. 

Random factor 
This parameter specifies the randomization between various stitches. This will force the 
stitches to be generated uneven. 

Trap on boundary 
This parameter specifies the tracking must be on the boundary of the object. 

One way stitching 

This parameter specifies that in single object to create stitches in one direction only. 



Backstitch 
There are two ways in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 
 

 

Piping 
Piping parameters are shown in the following dialog box: 
 



 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch gap 
This parameter specifies the distance between a next pair of stitches after a stitch. 



Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Style Height 
This parameter specifies the height of the style to e applied. If this parameter is 0 then 
style height is proportional calculated from the stitch length. 

Style 
This parameter specifies the style from the drop down. You can add new styles to the 
system with style editor. 

Frame from 
This parameter specifies the starting frame of the style. All the frames will be applied 
until frame end (if specified) is reached or there are no more frames left. 

Frame to 
This parameter specifies the ending frame of the style. All the frames will be applied until 
frame end (if specified) is reached. 

Style on line 
This parameter specifies that a line stitch should be created from the starting point till the 
other side and back track stitch should be created from the style used and it should follow 
till the end point. 

Line on style 
This parameter specifies that stitches should be created from the starting point of the line 
and a back track should follow from the last stitch and all the stitches in backtrack will be 
reverse of all the stitches generated while going forward. 

Alter motif height 
This parameter is used to specify that motif height must also be adjusted as stitch length 
varies. 

Mirror alternative motif 
This parameter is used to specify that while applying motif mirror alternative motif. 

Use motif stitch length 
This parameter is used to specify that use motif stitch length instead of stitch length. 

Use gap stitch as stitch 

This parameter is used to specify that all the gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps you to get two stitch lengths in the 
same object. 



First gap stitch as stitch 
This parameter is used to specify that first gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps one to get adjust stitch lengths for 
sequin. 

Snap to start end 
This parameter is used to specify that end point should at start of stitches point. 

Motif stitch length 
This parameter is used to specify the motif stitch length. 

Motif angle 
This parameter specifies that the motif (Style) should be rotated by this angle before it is 
applied to stitches. Following figure show style with 0 degree rotation and style with 90 
degree rotation. 

Skip motif first stitch 
This parameter is used to specify that if motif is used than skip first stitch of the motif. 

Skip motif last stitch 
This parameter is used to specify that if motif is used than skip last stitch of the motif. 

Omit first stitch 
This parameter is used to specify that omit first stitch of the object. 

Omit last stitch 
This parameter is used to specify that omit last stitch of the object. 

Skip first motif 
This parameter is used to specify that skip first motif of the object. 

Skip last motif 
This parameter is used to specify that skip last motif of the object. 

Use bare raw style 

This parameter is used to specify that style should not be rotated along the line of the 
object. It must be as it is as defined. 

Adjust stitches on curve 

This parameter is used to specify that if last stitch is not covered properly is must adjust 
stitches on curve of the object to fill properly. 



First gap stitch 
This parameter is used to specify that first create a gap stitch with half the length of stitch 
length and then creating remaining stitches. This helps us to apply sequins with single 
motif. 

Short/long stitch 
This parameter is used to specify that stitches at narrow piping will be less and more 
stitches at thick parts to object. Stitches will take a u turn to fill the objects. 

 

Limit no of turns 
This parameter is used to specify that turns in the objects should be no of turns defined. 

Variable length 
This parameter specifies that stitches should be generated with variable length line 
segments. If this parameter is unchecked than cord gap factor will be used to create 
stitches nearest to the outline. 

Fix divider 
This parameter is used to specify that stitches at generated at fixed area as shown in the 
diagram. 



 

Minimum Stitch length 
This parameter specifies the minimum stitch length to be used for creating stitches. 

Cord Gap 
Cord gap is used to tighten the line segments to the digitized outlines. This is the 
maximum distance allowed between the outline and the stitches. When this value is 
exceeded the stitch length is reduced to follow the outline more closely. 

Random factor 
This parameter specifies the randomization between various stitches. This will force the 
stitches to be generated uneven. 

Contour type 
There are two ways in which a contour can take place. One is continuous and the other 
one is spiral as specified in the dialog box. 

Backstitch 

There are two ways in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

Margins 
This parameter specifies the margin to be considered. First one is at start of stitches. 
Second one is last point. And the third one is the middle margin. 
 



 

Cross stitch 
Motif parameters are shown in the following dialog box: 



 

Column spacing 
This parameter specifies the width of the cross stitches. 

Row spacing 
This parameter specifies the height of the cross stitches. 

Repeat count 
This parameter specifies the no of stitches in each arm of the cross stitch. 

Fit to grid 

This parameter specifies that the cross stitches should be clipped to the boundary of the 
object. 

Add extra to fill 
This parameter specifies that the cross stitches should add extra points to generate 
smoothness. 

Fill points only 
This parameter specifies that the cross stitches should be generated on node points of the 
object. 



Cross at points 
This parameter specifies that the cross stitches should be generated on node points of the 
object without deviation. 

Boundary points 
This parameter specifies that the cross stitches should be generated on boundary points of 
the object. 

Balance cross 
This parameter specifies that no of stitches in each arm of the cross stitch must be same. 

Linear motif 
This parameter specifies the style should be applied horizontally and vertically rather 
than crossing. 

Skip Stitches 
This parameter specifies that the cross stitches should be skipped alternatively. 

Motif 
This parameter specifies the motif to be used in width or height. 

Size X 
This parameter specifies the size X (width) of the motif. 

Size Y 
This parameter specifies the size Y (height) of the motif. 
 



 
 

 





Motif 
Motif parameters are shown in the following dialog box: 

 

Row spacing 
This parameter specifies the row spacing of the motif. The number of times pattern 
appears vertically is calculated from this value. 

Row offset 
This parameter specifies the row offset of the motif for next row. 

Top spacing 
This parameter specifies the row space to be left at the top of the motif. 

Left spacing 
This parameter specifies the left space to be left of the motif. 

One way stitching 
This parameter specifies the one way stitching of the motif. 



Clip Motif to fit shape 
This parameter specifies that the motif should be clipped to the boundary of the object 
after fill. 

Trap on boundary 
This parameter specifies that the tracking must be on the boundary of the object. 

Smooth Go 
This parameter specifies that the motif should start and end at boundary of the object. 

Adjust stitches on curve 
This parameter specifies that the motif stitches should be adjusted to the boundary of the 
object. 

First gap stitch 
This parameter is used to specify that first create a gap stitch with half the length of stitch 
length and then creating remaining stitches. This helps us to apply sequins with single 
motif. 

Extend stitch 
This parameter is used to specify that if required extend the stitch to form a proper motif. 

Overlap last and first stitch 
This parameter is used to specify that fist and last of the two rows to became same. 

Omit last and first stitch 
This parameter is used to specify that last and fist of the two rows to be removed. 

Use last and first stitch 
This parameter is used to specify that last and fist of the two rows to be removed. 

Use gap stitch as stitch 
This parameter is used to specify that all the gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps you to get two stitch lengths in the 
same object. 

First gap stitch as stitch 
This parameter is used to specify that first gap stitches created while stitches generated, 
must be converted to stitches of the object. This helps one to get adjust stitch lengths for 
sequin. 

First gap stitch 
This parameter is used to specify that first create a gap stitch with half the length of stitch 
length and then creating remaining stitches. This helps us to apply sequins with single 
motif. 



Motif 
This parameter specifies the motif to be used. 

Size X 
This parameter specifies the size X (width) of the motif. 

Size Y 
This parameter specifies the size Y (height) of the motif. 

Column size 
This parameter specifies the distance between a pair of motifs.  

Stitch Gap 
This parameter specifies the gap distance between a pair of motifs. 

Repeat count 
This parameter specifies the number of time a motif to run at the same place. 

Column size 
This parameter specifies the distance between a pair of motifs. 

Line Parameter 
Some of the parameters of the line can be changed here for line fill. A repeat count may 
be used to create auto style. 
 



 
 

Ripple 
Ripple parameters are taken from Tatami fill parameters. These are shown in the 
following dialog box: 

 



 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Minimum stitch length 

This parameter specifies the minimum distance between a pair of stitches. Any stitch less 
than this value will be ignored. 

Offset fractions 
This parameter specifies the distance between a pair of stitches on different lines. By 
manipulating offset fractions, you can create fills where obvious split lines are not visible 
and the stitch penetrations are more clearly visible. 



Offset sequin 
This parameter specifies that sequins should be placed at offset position. 

Backstitch 
There are two ways in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

How to use ripple fill 
First create an object for Tatami fill. Now create a line object and add sufficient points to 
make it as a sin wave curve.  

 



Water fill 
Water fill parameters are taken from Tatami fill parameters. These are shown in the 
following dialog box: 

 

 

Stitch spacing 

This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Minimum stitch length 
This parameter specifies the minimum distance between a pair of stitches. Any stitch less 
than this value will be ignored. 



Offset fractions 
This parameter specifies the distance between a pair of stitches on different lines. By 
manipulating offset fractions, you can create fills where obvious split lines are not visible 
and the stitch penetrations are more clearly visible. 

Offset sequin 
This parameter specifies that sequins should be placed at offset position. 

Backstitch 
There are two ways in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

How to use water fill 
First create an object for Tatami fill and fill it with water fill. 
 

 

Jall fill 
Jall fill parameters are taken from Tatami fill parameters. These are shown in the 
following dialog box: 



 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Minimum stitch length 

This parameter specifies the minimum distance between a pair of stitches. Any stitch less 
than this value will be ignored. 

Offset fractions 
This parameter specifies the distance between a pair of stitches on different lines. By 
manipulating offset fractions, you can create fills where obvious split lines are not visible 
and the stitch penetrations are more clearly visible. 



Offset sequin 
This parameter specifies that sequins should be placed at the offset position. 

Backstitch 
There are two types in which a backstitch can take place. One is offset corners and the 
other one is square corners as specified in the dialog box. 

 

Stipple fill 
Stipple fill parameters are shown in the following dialog box: 



 

Column Width 
This parameter specifies the distance between the outlines generate. 

Create Outline 
This parameter specifies that create a separate outlines which can be used for line fill. 
 



 

Design setting 
Once a design is punched a lot of customization is required to make it run on the 
machine. We discuss it in detail about it: 

Underlay 
Underlay parameters are shown in the following dialog box: 



 

Underlay types for Satin 
Evx provides a selection of underlay types to choose from for Tatami like fill. You can 
choose an underlay from the dropdown window. 
 
Choose the value from the dropdown for this parameter. The choices that you have for 
this field are: 

Tracking Tracking Only 

Single Single underlay for one side only 

Double Both sides underlay 

Zigzag Zigzag underlay 

Zigzag Plus Zigzag plus underlay 

Cross Cross underlay 



Cross Plus Cross plus underlay 

Netting Netting underlay 

Netting Plus Netting plus underlay 

Piping Piping underlay 

Piping Plus Piping plus underlay 

Zigzag 
Midway 

Zigzag Midway underlay 

Netting 
Midway 

Netting Midway underlay 

Underlay types for Tatami 
Evx provides a selection of underlay types to choose from for Tatami like fill. You can 
choose an underlay from the dropdown window. 

 
Choose the value from the dropdown for this parameter. 
The choices that you have for this field are: 

Edging Edging only 

Piping Piping underlay type 

Piping + This is Piping + edging underlay 

Netting Netting type underlay 

Netting+ This is Netting + edging underlay 

Star Star type underlay 

Star+ This is Star + edging underlay 

Zigzag Zigzag type underlay 

Zigzag Double This is Zigzag double underlay 

Jall Jall type underlay 

Jall + Star This is Jall + Star underlay 

Netting + Star Netting + Star underlay 

Margin for underlay 
This parameter specifies the offset distance at which underlay should be created. This is 
used in case we created our objects with dual types (dual Bezier). First parameter is the 
offset at starting of object. Second parameter is the offset at the end of the object. And the 
third one is the offset on both sides of the object. 



Underlay spacing level 
Choose the value from the dropdown for this parameter. 
The choices that you have for this field are: 

Normal Normal spacing 

Thin (Light) Thin spacing 

Thick(Dense) Thick spacing 

Stitch spacing first 
This parameter specifies stitch spacing for the first underlay. 

Stitch spacing second 
This parameter specifies stitch spacing for the second underlay. 

Stitch length first 
This parameter specifies stitch length for the first underlay. 

Stitch length second 
This parameter specifies stitch length for the second underlay. 
 
 
 



 
 

Add outline  
Add outline parameters are shown in the following dialog box: 
 



 
 

Border values 
These parameters are explained as follows: 
 

Offset This is the value of the offset by which outline will be 
added to the object 

Add 
Inside 

If checked, the outline will be added inside the object; 
otherwise it will be added outside the object. 

Same 
color 

If checked the outline will have the same color as of the 
selected object, otherwise it will pick up the next color 
in the order. 

Number 
of outline 

This is the value of the number of outline to be added. 

 



Stitch type 
This parameter specifies the stitch type of the outlines to be added: 
 

Central Satin Outline will be central satin stitch. 
Satin Outline will be satin stitch. 
Line Out line will be line stitch. 

 

Column width 
This parameter specifies the column width of the central satin. 

Stitch spacing 
This parameter specifies the distance between a pair of lines. This is also called stitch 
density. 

Stitch length 
This parameter specifies the distance between a pair of stitches. You can see in the above 
diagram. 

Number of run 
This parameter specifies the number of runs for a line stitch. 

Style 
This parameter specifies the style from the drop down. You can add new styles to the 
system with style editor. 
 

 
 



Object Property 
Object property parameters are shown in the following dialog box: 

 

Area fill edge type 
Choose the value from the dropdown for this parameter. 
The choices that you have for this field are: 

None (Hole) The boundary of this object will act like a hole in the area fill. 

Patch The boundary of this object will act like a patch in the area fill. 

Pattern The boundary of this object will act like a pattern in the area fill.

Line stop over 
The boundary of this object will act like a Line stop over in the 
area fill. 

Ripple fill type 
The boundary of this object will act like a ripple in another 
ripple filled object. 



Crop fill type Crop the stitch with this object 

Crop fill type 
Before 

Crop the stitch with this object before splitting the stitches using 
auto jump or auto splitting. 

Balloons 
Balloons used in central fill to make curves in the central object. 
Central outline will start with balloons and end with balloons to 
give a curve shape in regular central stitches. 

Crop fill type 
Reverse 

Crop the stitch with this object and at cropin position reverse the 
stitching. 

Splitters 
These will split the stitches at this object and fill these segments 
separately. 

Area edge type 
This parameter specifies the type of edge type for this object. 
None 
(Hole) 

This object is of type hole. If this object is grouped in Tatami, program fill, motif 
fill etc. then a hole will be created by its boundary points. 
 

Patch This object is of type patch. If this object is grouped in Tatami, program fill, motif 
fill etc. then a patch will be created by its boundary points. It means whenever any 
stitch is crossing these kinds of objects, they will be starting and ending at the 
boundary of this object. 



Pattern This object is of type pattern. If this object is grouped in Tatami, program fill, 
motif fill etc. then a pattern will be created by its boundary points. It means 
whenever any stitch is crossing these kinds of objects, they will be starting and 
ending at the boundary of this object. More over, these will be filled in the entire 
fill area. 

Line stop 
over 

This object is of type line stop over. This means that as and when any stitch is 
crossing this object, a stitch will be marked at its boundary. 



 
 

Ripple 
type 

This object is of type ripple. If this object is grouped in Tatami and a ripple fill is 
applied then a ripple stitch will be created by its boundary points. 



Crop fill 
type  

Crop the stitch with this object. 



 
Crop fill 
type 
Reverse 

Crop the stitch with this object and at cropping position reverse the stitching. 

 
Balloons Balloons used in central fill to make curves in the central object. Central outline 

will start with balloons and end with balloons to give a curve shape in regular 
central stitches. 

 
Splitters These will split the stitches at this object and fill these segments separately. 



 

Smart end point 
This parameter specifies that this object should consider smart end point in line filling 
type of objects. This is very much useful to avoid backtrack in joining an object. 

Rock in join 
This parameter specifies that this object should not alter its stitches in branches (joining). 
This is very much useful in sequin designs where we don’t want that the pattern of the 
sequin should not change and route of the design is made. 

Place On line parameters 
Place On line tool allow the user to place the objects on a curve. Rename the curve object 
with –N where N can be 1, 2 , 3 etc. Select objects to be placed, and click this place on 
line tool. 
Place On line parameters are shown in the following dialog box: 



 

Gaps as percentage 
This parameter specifies that gaps to be calculated as percentage define in name property 
of the object. 

Mirror Alternative motif 
This parameter specifies that mirror alternative motif. 

Mirror Alternative motif at same point 
This parameter specifies that mirror alternative motif at the same point. 

Scale to fit 
This parameter specifies that motif need to be scaled according the current stitch length. 
So smaller the stitch smaller will be the object. 

Gravitational fall 

This parameter specifies that motif should be placed and should be vertically placed. 

Motif gradient 
This parameter specifies that motif should be gradually increase or decrease 
proportionally with the previous motif. 

Gradient threshold 
This parameter specifies that motif should be not cross gradient threshold value. Once 
reached this value size of the following motif will be unchanged. 



Motif gradient angle 
This parameter specifies that motif should rotate each time with this value. 

Start at stitch 
This parameter specifies that motif should be counted from Start at stitch position rater 
than first stitch position. 

 
 

Spiral parameters 
Spiral parameters are shown in the following dialog box: 

 

Spiral width 
Spiral width is the distance between two pairs of spirals. 

Number of run 
Number of run is the number of spirals in the object. 
 



Duplicate Array 
Duplicate Array parameters are shown in the following dialog box: 

 

Array size –X Horizontal 
This parameter specifies the Array size –X Horizontal the number of objects you want to 
place horizontally. 

To left 
This parameter specifies the Array size –X Horizontal to start placing objects to the left 
of the objects. 

Array size –Y Vertical 
This parameter specifies the Array size –Y Vertical the number of rows you want to 
place. 

To top 

This parameter specifies the Array size –Y Vertical to start placing objects from bottom 
to top. 

Spacing –X Horizontal 
This parameter specifies the space between two objects from left to right. 

Spacing –Y Vertical 
This parameter specifies the space between two rows you want to place. 



Fit equally in the space above 
This parameter specifies the all the objects should be fit in the space defined above. 

Color wise priority 
This parameter specifies that objects of the same colors to be place the way they are 
selected. 

Auto sheet setting 
This parameter specifies that objects must be place in such a way they are matching with 
head to head distance uniformly. 

Alternative middle offset 
This parameter specifies that objects place in the alternative rows to be in the middle of 
the previous row objects. 

 
 
 

On the fly satin 
On the fly satin objects can be created by specifying the no of objects to be part of it and 
an object to be duplicated. A circle will be created inside the crafted object and a satin in 
filled in between them. 
Rotation properties are used which are shown in the following dialog box: 



 
 

Rotation Angle 
These parameters specify that objects created to be rotated by this degree. 

Number 
These parameters specify that number of objects to be created and rotated. 

Duplicate 
These parameters specify that number of objects to be created should be duplicated. 

Global application parameter 
Global parameters which are used at various stages, shown in the following dialog box: 
 



 

Line Offset 
This parameter specifies the offset with which lines to be increased/decreased when 

expand line command is used. 

Bend offset 

This parameter specifies the offset with which bend to be created when Add bend  
command is used. 

Closed nearly offset 
This parameter specifies the offset to be used to specify that object is almost closed, if 
last and the first node of the object is less than this offset. One can select almost closed 

objects by holding Control key and using Close shape command. 

Satin auto complete distance 
This parameter specifies the offset distance at which other side of the dual Bezier curve 
to be automatically generated by pressing shift X or Shift M in dual side punching tool. 

Short node distance 
This parameter specifies the distance at which nodes must be removed if the distance 

between the nodes is less than this distance in remove short nodes command. 



Short objects distance 
This parameter specifies to select objects whose length and with is less than this distance 
in select short objects command. 

Number of commands to repeat 
This parameter specifies previous transformation commands to be repeated this number 
of times while pressing R the repeat command. 
 
 
 

Drawing Object 
Drawing objects are the objects without stitches and are just for the purpose of making 
sketch on the screen. These can also be imported from DXF file format created by other 
software. Drawing object parameters are shown in the following dialog box: 
 
 

 

Column width 
This parameter specifies the column width of the drawing object. 
 



Stitch processing 
Stitch processor is a very powerful tool to increase or decrease stitches in a DST file. 
Stitch processor parameters are shown in the following dialog box: 
 

 
 

Stitch density 
This parameter specifies to decrease or increase satin density by a percentage. If this 
value is 80%, it means reduce the density by 20% and hence design or selection will have 
20% less stitches. In the same way if this value is 125% (say), the design or selection will 
have 25% more stitches. 
 

 
 
 



Processing DST object width 
Stitch processor is a very powerful tool to increase or decrease stitch width in a DST file. 
Processor parameters are shown in the following dialog box: 
 

 
 

Change object width 
This parameter specifies to decrease or increase width in mm. If this value is 2 mm, it 
means increase the width by 2 mm. In the same way if this value is -2 mm, then design or 
selection width will be reduced by 2 mm. 

Side 
This parameter specifies the point of origin from where we should increase or decrease 
the width. 
 

 
 



Remove short stitches 
Remove short stitch is a very powerful tool to increase productivity. This tool helps us to 
remove all the stitches unto defined length. 
 

 
 

Maximum Stitch length 
This parameter specifies the maximum length of the stitches to be removed. Any stitch 
having length less than or equal to this value will be removed. 
 
 
 


